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Preface

The C-CURE 9000 OTIS Elevator System Integration Guide is for new and experienced security system users who
want to learn to use this product for the C<CURE 9000 Security Management System.

In this preface

How to Use this Manual . ... 8
Finding More Information .. 10
CONV BNt ONS - 11



How to Use this Manual

This manual contains chapters and appendices that provide the following information about the C<CURE 9000
OTIS Elevator System integration:

Chapter 1: Introduction

This chapter describes the OTIS Elevator System integration and its features.

Chapter 3: Installation

This chapter provides the pre-installation requirements, installation procedure, licensing information, and the uninstall
procedure.

Chapter 2: OTIS Elevator System Configuration

This chapter provides the OTIS Elevator System Editor configuration procedures.

Chapter 5: OTIS Default Landing Matrix Configuration

This chapter provides the default landing matrix configuration procedures.

Chapter 6: OTIS Landing Configuration

This chapter describes how to configure a landing (floor).

Chapter 7: OTIS DEC Clearance Landing Matrix Configuration

This chapter provides the DEC clearance landing matrix configuration procedures.

Chapter 8: OTIS DEC Configuration

This chapter provides the DEC (Destination Entry Computer) configuration procedures.

Chapter 9: OTIS User Types

This chapter describes how to associate personnel to a User Type.

Chapter 10: OTIS Events and Actions

This chapter describes the OTIS events and the steps to configure them.



Chapter 11: Monitoring OTIS Elevator Activity

This chapter describes the C<CURE 9000 Monitoring Station Activity Viewer and also provides the procedure to cancel
OTIS manual actions.

Chapter 12: Journal and Audit Messages

This chapter discusses the Journal and the Audit messages and how to locate them.

Chapter 13: Troubleshooting

This chapter helps to resolve problems you may encounter with C+.CURE 9000 OTIS Elevator Integration.

Appendix A: Third-Party Copyright and Trademarks



Finding More Information

Software House Support Portal

The Software House Support Portal provides software downloads, knowledge-based articles, technical documents, and
tips to install and use Software House products. Qualified integrators can register to access the Software House Support
Portal at: https://support.swhouse.com/#/register. The email address that you use to register to the portal must be the
same one you used for the certification course. If the request is approved, logon credentials are emailed 24 to 48 hours
after the request is received.

User guides

User guides are available on the Software House website and on the Software House Support Portal.

m Onthe Software House website, navigate to the C<CURE 9000 section, and click the Documents tab. You must sign
in to access the full range of documentation: https://www.swhouse.com/Products/software_ CCURE9000/

m On the Software House Support Portal, log on, and then navigate to the C<CURE 9000 documentation section:
https://support.swhouse.com/#/product/c-cure-9000/documentation

NOTE:

Download user guides to C*CURE 9000 server machines, client machines, or both, where required.

Software downloads
Updated software is available on the Downloads page of the Software House Support Portal:

https://support.swhouse.com/#/software-downloads

NOTE:

To access software downloads, you must log on to the Software House Support Portal.

Online Help

You can access C*CURE 9000 Help by pressing F1 or clicking Help from the menu bar in the Administration/Monitoring
Station applications.


https://support.swhouse.com/#/register
https://www.swhouse.com/Products/software_CCURE9000/
https://support.swhouse.com/#/login?return=%2Fproduct%2Fc-cure-9000%2Fdocumentation
https://support.swhouse.com/#/login

Conventions

This manual uses the following text formats and symbols.

Convention

Meaning

Bold

This font indicates screen elements, and also indicates when you should take a direct action in a procedure.
Bold font describes one of the following items:

* Acommand or character to type, or

* Abutton or option on the screen to press, or

» Akeyonthe keyboard to press

* Ascreen elementor name

blue color text

Indicates a hyperlink to a URL, or a cross-reference to a figure, table, or section in this guide.

Regular italic font Indicates a new term.

<text>

Indicates a variable.

The following items are used to indicate important information.

NOTE

TIP

A\

O
o

Indicates a note. Notes call attention to any item of information that may be of special importance.

Indicates an alternate method of performing a task.

Indicates a caution. A caution contains information essential to avoid damage to the system. A caution
can pertain to hardware or software.

Indicates a warning. A warning contains information that advises users that failure to avoid a specific
action could result in physical harm to the user or to the hardware.

Indicates a danger. A danger contains information that users must know to avoid death or serious injury.




Software House Customer Support Center

Telephone Technical Support

During the period of the Agreement, the following guidelines apply:

Software House accepts service calls only from employees of the Systems Integrator of Record for the installation
associated with the support inquiry.

Before Calling

Ensure that you:

Are the Dealer of record for this account.

Are certified by Software House for this product.

Have a valid license and current Software Support Agreement (SSA) for the system.
Have your system serial number available.

Have your certification number available.

Hours | Normal Support Hours Monday through Friday, 8:00 a.m. to 8:00 p.m., EST. Except holidays.

Emergency Support Hours | 24 hours/day, seven days a week, 365 days/year.
Requires Enhanced SSA “7 x 24” Standby Telephone Support
(emergency) provided to Certified Technicians.

For all other customers, billable on time and materials basis.
Minimum charges apply — See MSRP.

Note: For telephone support contact numbers for all regions, refer to either of the following pages:

On the Software House website, go to https://www.swhouse.com/Support/Contact Technical Support

On the Software House Support Portal, go to https://support.swhouse.com/#/contact



https://www.swhouse.com/Support/Contact_Technical_Support
https://support.swhouse.com/#/contact

Introduction
This chapter describes the OTIS System Elevator and the integration with C«CURE 9000.
In this chapter:
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Overview

The OTIS Compass Elevator System integration with the C<CURE 9000 provides security to particular landings (floors) in
a multi-level building by ensuring that only those authorized may go to a particular landing, or exit on that landing. Access
to particular landings is determined through a swipe of a card to a card reader called a Destination Entry Computer (DEC)
outside of the elevator. The card reader accesses the personnel privilege assigned to a specific OTIS Elevator access
configuration.

How OTIS Compass Integration Works

In a typical Destination Dispatching System (DDS) deployment, a C*CURE 9000 reader/keypad combination is deployed
in proximity to each OTIS Destination Entry Computer (DEC) — a touch-screen or keypad device. An OTIS DEC
communicates with an OTIS Destination Entry Server(DES) that manages a group of elevators. The C*CURE 9000
contains objects that represent the DER, DES, and DECs, including their relationships to Personnel,Clearances, and
Floors.



Features

The OTIS integration with the C«CURE 9000 offers the following features:

m Supports secured access to particular floors of multi-level building by ensuring that only the authorized personnel can
enter or exit on that floor.

m Supports Multicast and Unicast Heartbeat Types.

m Supports Interface Control Document (ICD) Version 1, Version 2, Version 2.2, Version 3, and Version 3.1.

NOTE It is recommended to configure all OTIS DES hardware with same ICD versions.

m Supports OTIS Configuration user interface to configure ICD version and Heartbeat Type.

m Supports the following Operational Modes which can also be scheduled.:

« Mode 1 - Default Floor Only

« Mode 2 - Access to Authorized Floors

« Mode 3 - User Entry of Destination Floor
« Mode 4 - User Entry of Default Floor

m Supports floor selection messages fora DEC.

m Supports Reason Codes for denied floor access.

m Supports a Destination Entry Server (DES) Audit display that shows the elevator activity of Personnel.
m Supports front and rear door configuration.

m Supports the use of card swipe on the inbuilt reader of the DEC.

m Supports Schedule-based floor access for all personnel.

m Supports DEC PIN code entry. When this feature is enabled the customer can use PIN code entry to navigate to
floors in the building without needing to swipe their card.

m Supports C*CURE 9000 event configuration based on elevator communication status.

m Supports Remote monitoring using the C«CURE 9000 Monitoring Station.

m Supports 255 floors by each elevator group, and the front and rear doors of each elevator cab.

m Supports default floor configuration.

m Supports Secure or unsecure floors through Events, Schedules, or Operator menus.

m Supports the assigning of an exemption group who can access secured floors.

m Supports Maintenance mode, which is used to limit information about an object, displays on the Monitoring Station.

m Supports 15 DES per C-CURE Server and 25 DEC per DES. Rrefer C<CURE Release Note for information on
detailed performance results.

m Supports TLS 1.2 for security.

m Supports multiple iStar doors configuration through iStar Doors tab under DEC object.



Architecture
The architecture of the OTIS Elevator Integration shows how the C<CURE 9000 security system interacts with the OTIS

Elevator Destination Entry System. The following images depict the relationship between the OTIS Elevator system and
C-CURE 9000.

Figure 1: C-CURE 9000 OTIS Elevator Integration Architecture (with iISTAR Controller)
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Figure 2: C<CURE 9000 OTIS Elevator Integration Architecture (withoutiSTAR Controller)
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Terminology

Table 1 on Page 18 describes the terms and their definitions related to the OTIS Elevator System integration.

Table 1: OTIS Elevator System Integration Terminology

Term Definition

DDS Destination Dispatching System. The OTIS system used to process passenger input and route traffic to elevators.

DER Destination Entry Redirector. The OTIS name for the device that connects all elevator groups and allows the routing of passengers
from DECs in a common area to any elevator groups in a building.

DES Destination Entry Server. The OTIS name for the device that controls the routing of passengers to a group of elevators.

Allowed Allowed Floors are OTIS floor numbers that are designated ata DEC as accessible without a credential.

Floors

Authorized Authorized Floors are floors that are specifically identified as accessible in a Personnel credential. Authorized Floors are defined in

Floors C+CURE 9000 by including them in a Clearance and assigning the clearance to a Personnel record.

DEC Destination Entry Computer. ADEC is a touch screen or keypad device that is used for passenger interaction with the OTIS
System.

ICD Interface Control Document

PIN Personal Identification Number




Operation Modes

C-CURE 9000 OTIS Compass Integration supports the four Operational Modes available with the OTIS Compass
Destination Entry System. You specify the Operational mode used for an OTIS DEC on the OTIS DEC Editor General
tab.

Default Floor (Operation Mode 1)

In this operation mode, each authorized cardholder has been assigned a default floor, and certain floors may have been
designated as Allowed Floors (public access is allowed without a credential).

A potential passenger presents a credential at a C+CURE 9000 credential reader and it is interpreted by the C<CURE
9000, or a potential passenger enters a destination floor at the DEC.
This activity results in one of the following responses:

m If acredential was presented and validated, a default floor for the passenger is transmitted to the DEC from C<CURE
9000, the DEC forwards the request to the DES for a car assignment., and displays that car assignment to the
passenger.

m |f C-.CURE 9000 determines that the credential is invalid or the destination entered is not allowed, then C<CURE
9000 transmits this information to the DEC, and the DEC displays a message informing the potential passenger that
the destination request has been denied.

m [f the destination request is allowed by the DEC, the DEC forwards the request to the DES for a car assignment, and
displays that car assignment to the passenger.

Access to Authorized Floors (Operation Mode 2)

In this operation mode, each authorized cardholder has been assigned Clearances that provide access to specific floors.
A potential passenger presents a credential at a C<«CURE 9000 credential reader and selects a destination floor at the
OTIS DEC. C-CURE 9000 interprets the credential and transmits to the OTIS DEC an admit message along with a list of
authorized floors, or a reject message.

This activity results in one of the following responses:

m The credential holder is given a car assignment by the DEC because their credential and their destination floor
request were valid.

m The DEC displays a rejection message and informs the passenger that they should seek assistance.

User Entry of Destination Floor (Operation Mode 3)

In this operation mode, the potential passenger selects a destination floor. This may be performed with or without the
presentation of a credential to C<«CURE 9000.

This activity results in one of the following responses:

» The passenger's requested floor is accepted without C*CURE 9000 authorization, the DEC forwards the request
to the DES for a car assignment, and displays that car assignment to the passenger.

» If the passenger presented a credential to C+CURE 9000, their Authorized Floors are transmitted to the DEC from
C-CURE 9000, and if their requested floor is authorized, the DEC forwards the request to the DES for a car
assignment, and displays that car assignment to the passenger.

+ |f C+.CURE 9000 informs the DEC that the credential and/or the requested floor is invalid, the DEC displays a
message informing the potential passenger that the destination request has been denied.



Default Floor or User Entry of Destination Floor (Operation Mode 4)

In this operation mode, the potential passenger presents a credential to the C+CURE 9000 Reader. Within a timeout
period (specified on the DDS Editor General tab), the passenger may override the default floor and choose another
destination floor. The timeout period is based on Personnel record settings in C+.CURE 9000, as transmitted to the Otis
DEC. If the passenger is a Standard Passenger then the timeout period is 3 seconds. If the passenger is identified in
C+-CURE 9000 as requiring Alternate Shunt for Americans with Disabilities Act (ADA) compliance, then the timeout is 6
seconds.

This activity results in one of the following responses:

+ C+CURE 9000 transmits the passenger's Default and Authorized Floors to the DEC, the DEC forwards the
request to the DES for a car assignment, and displays that car assignment to the passenger.

» C+CURE 9000 informs the DEC that the credential and/or the requested floor is invalid, and the DEC displays a
message informing the potential passenger that the destination request has been denied.



ICD Version and Heartbeat Type Settings

OTIS Configuration allows you to set ICD Versions and Heartbeat Types for communicating with the OTIS Elevator
Server (DES). OTIS Configuration settings determines which ICD Version and Heartbeat Type is used for the OTIS

Integration.
This configuration is pre-configured, and default ICD Version is set as 3.1 and default Heartbeat Type is set as Multicast.
For more information see, Updating the OTIS Configuration for the OTIS Integration on Page 21

It is recommended to configure ICD Version and Heartbeat Type before configuring the OTIS Elevator

NOTE objects.

NOTE ICD Version 1.0 does not support the following features:
» Audit messages
* PIN code entry

» Rear doors for elevators

Updating the OTIS Configuration for the OTIS Integration
OTIS Configurations determines which ICD Version and Heartbeat Type is used for the OTIS Integration.

|
To Update the OTIS Configuration for the OTIS Integration

1. Inthe Administration Station, on the Hardware pane, expand the Company Name folder.
2. Right click the OTIS Configuration and select Edit.

3. Select the required ICD version from the ICD Version dropdown and Heartbeat Type from the Heartbeat Type
dropdown.

4. Click Save and Close.

Any changes you make, occurs immediately, and do not require a driver restart to take effect.



Figure 3: OTIS Configuration - OTIS Integration
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Hotec ICD version 1.2.3 only supporis Multicast Heartbeat type.
ICD version 2.2. and 3.1 supports Multicast and Unicast Heartbeat types

Refer to Table 2 on Page 22 for the configured ICD Versions and Heartbeat Types.
Table 2: Supported combinations of ICD Version and Heartbeat Type

Serial Number ICD Version Heartbeat Type
1 1 Multicast
2 2 Multicast
3 2.2 Multicast
4 2.2 Unicast
5 3 Multicast
6 3.1 Multicast
7 3.1 Unicast
NOTE « Option to configure ICD Versions through System Variable is no longer supported.

« Changing the ICD Versions (or) Heartbeat Types (or) both the settings together will result in the
loss of communication with DES and DECs configured in the system momentarily but after a few
seconds (approx 5-7 seconds), communication re-establishes automatically.



OTIS Elevator System Configuration

This chapter describes how to setup the OTIS Elevator System using the OTIS Elevator System Editor.

In this chapter:

Creating an OTIS Elevator System Folder ... il 24
Accessing the OTIS Elevator System Editor Dialog Box ... .. 25
OTIS Elevator System Editor Dialog BOX ........ ..o L 26
Landing Tab ..o 31
TGOS TaD .. 32
StatUs Tab L.l 35
OVEITIAE Tab L 37



Creating an OTIS Elevator System Folder

To Create a New OTIS Elevator System Folder

1.

2
3
4,
5

Double-click the Administration Workstation icon on the desktop to open it.

(Alternately, you can select All Programs>Tyco>C+*CURE 9000>Administration Station.)

. Click the Hardware pane button.

Right-click Hardware under the Hardware tree and select Hardware Folder>New.

Enter a name and description (optional) for the OTIS Elevator System folder.

. Click Save and Close.

The new folder is listed under the Hardware tree.



Accessing the OTIS Elevator System Editor Dialog Box

This section explains how to access the OTIS Elevator System in the C-CURE 9000.

NOTE

This section assumes that you already created a folder for the OTIS Elevator System. See

Creating an OTIS Elevator System Folder on Page 24 for more information.

To Access the OTIS Elevator System Editor

1.

2
3.
4

Open the C*CURE 9000 Administration Station.

. Click the Hardware Pane.

Click the Hardware drop-down menu and select Hardware Folder.

25.

. Right-click the OTIS Elevator System folder and select OTIS Elevator System>New, as shown in Figure 4 on Page

Figure 4: Accessthe OTIS Elevator System Dialog Box
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The OTIS Elevator System dialog box, shown in Figure 5 on Page 27, opens with the General tab selected.



OTIS Elevator System Editor Dialog Box

The OTIS Elevator System Editor dialog box, shown in Figure 5 on Page 27, is used to create an identity for the elevator
system, select the DES or DER option, enter IP addresses for the primary and backup servers, configure triggers and
events, view configured Landings in the elevator group, and optionally change state images..
For more information on DES and DER, see the following:

m Destination Entry Server (DES) on Page 26

m Destination Entry Redirector (DER) on Page 26

Destination Entry Server (DES)

An OTIS DES is a Destination Entry Server that supports the DECs (Destination Entry Computers) for a group of
elevators. In the OTIS Elevator System, there are two DES to configure. One DES acts as a primary server (Server A)
and the other as a backup server(Server B) in case the primary encounters a problem and cannot serve its intended
function. The backup server is provided in the event that it is needed as a fail-over device.

Destination Entry Redirector (DER)

An OTIS DER is a Destination Entry Redirector, an optional server type, whose function is to support building-wide DEC
devices. The DER connects to all elevator groups and allows DEC’s at a common entry point in the building, for example
in a Lobby, to accept destination requests for any floor in the building.
For more information, see the following:

m Accessing the OTIS Elevator System Editor Dialog Box on Page 25

m OTIS Elevator System Editor Dialog Box Definitions on Page 27

m OTIS Elevator System Editor Tasks on Page 28

m OTIS Elevator System Editor Tabs on Page 28



Figure 5: OTIS Elevator System Editor Dialog Box
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OTIS Elevator System Editor Dialog Box Definitions

Table 3 on Page 27 describes the OTIS Elevator System Editor dialog box fields and buttons.

Table 3: OTIS Elevator System Editor Dialog Box Definitions

Field/Button Description

Name Aunique name identifying the OTIS elevator system.
* The name is not case-sensitive
¢ Minimum number of characters: 1

* Maximum number of characters: 100

Description Optional. A description for the OTIS elevator system.
» The description is not case-sensitive.
* Minimum number of characters: None

*  Maximum number of characters: 500




Table 3: OTIS Elevator System Editor Dialog Box Definitions (continued)
|

Field/Button Description

Save and Close Saves the configuration and closes the dialog box.

General Tab

Device Type Choose either DER or DES from the drop-down list.

TCP/IP Options

For Device Type-DES Set the unique Server A IP Address.

Server B IP address will update accordingly by using the same subnet third
address as you chose for the Primary IP Address.

For Device Type-DER Set the unique Server A IP Address.

OTIS Elevator System Editor Tabs

The following sections provide information about the OTIS Elevator System Editor tabs:
m Landing Tab on Page 31
m Triggers Tab on Page 32
m Status Tab on Page 35
m Override Tab on Page 37
m State Images Tab on Page 39

OTIS Elevator System Editor Tasks
This section describes the tasks performed in the OTIS Elevator System Editor Dialog box.

The following tasks are performed in the OTIS Elevator System Editor dialog box - General tab:
m Creating an OTIS Elevator System on Page 28
m Creating an OTIS Elevator System Template on Page 29
m Editing an OTIS Elevator System on Page 29
m Viewing OTIS Elevator System Configurations on Page 30
m Deleting an OTIS Elevator System on Page 30

Creating an OTIS Elevator System

|
To Create an OTIS Elevator System

1. Openthe C<CURE 9000 Administration Station.

2. Click the Hardware pane.



3.
4.

NOTE

Click the drop-down menu located under Hardware and select Hardware Folder.

Right-click the folder you created in the Hardware tree and select OTIS Elevator System>New.

(Alternately, you can create a new folder by clicking on New located next to the Hardware drop-down menu.)

OTIS Elevator System is used for the folder name throughout this guide.

The OTIS Elevator System Editor opens. See OTIS Elevator System Editor Dialog Box on Page 26

Enter a name for the elevator group in the Name field.

Enter a description (optional) for the elevator group in the Description field.

7. Click the General tab and perform the following:

a. Enterthe IP address of the primary OTIS Group Controller in the Server A field.
b. Enterthe IP address of the backup OTIS Group Controller in the Server B field.

Click Save and Close.
The Elevator System is listed under the OTIS Elevator System folder in the Hardware tree.

Go to OTIS Default Landing Matrix Dialog Box on Page 59 to configure the default landing matrix.

Creating an OTIS Elevator System Template

Creating a template saves you time because you do not have to re-enter the same information again.

|
To Create a Template

1.
2.
3.

Click the Hardware pane.
Click the drop-down menu located under Hardware and select Hardware Folder.

Right-click the OTIS Elevator System folder in the Hardware tree and select OTIS Elevator System>New
Template.

Enter the information for the OTIS Elevator System template.

5. Click Save and Close.

The new template is listed under OTIS Elevator System>Templates.

Editing an OTIS Elevator System

|
To Edit an OTIS Elevator System

1.

Double-click the Elevator System under the OTIS Elevator System folder in the Hardware tree to open the
OTIS Elevator System dialog box.

(Alternately, you can right-click the Elevator System and select Edit from the context menu.)
Make the changes to the configuration.

Click Save and Close.



Viewing OTIS Elevator System Configurations

To View OTIS Elevator System Configurations

1.

Select OTIS Elevator System from the Hardware drop-down menu.

2. Click the green right arrow & to open a Dynamic View displaying all OTIS Elevator System Configurations.

The OTIS Elevator System tab opens in the Dynamic View displaying a list of OTIS Elevator System configurations

Deleting an OTIS Elevator System

To Delete an OTIS Elevator System

1.

o o > w0 DN

Click the Elevator System under the OTIS Elevator System folder in the Hardware tree.
Click a Landing to expand the DEC configurations.

Right-click the DEC configuration and select Delete from the context menu.

Repeat step 3 for all DEC configurations listed under the Landing.

Right-click the Landing and select Delete from the context menu.

Right-click the Elevator System and select Delete from the context menu.



Landing Tab

The Landing tab, shown in Figure 6 on Page 31, lists the configured Landings (floors) for the elevator group. This tab is
read-only.

Figure 6: OTIS Elevator System Editor — Landing Tab
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Triggers Tab

The Triggers tab, shown in Figure 7 on Page 32, is used to configure triggers to activate events.

Triggers are used by C*CURE 9000 to activate specific actions when a particular predefined condition occurs. Once the
Elevator status matches one of these values, the linked Activate Event action is triggered and the user-specified event is
set to an active state (if allowed by the event, which should be armed at the time). Typically, you would use the activated
event to send messages to a security guard or administrator when an elevator has a particular status.

By creating new rows and selecting different values for each row, each value of the Status field can trigger its own event.
It is also possible to trigger two different events for the same status value by creating two rows with the same value and
then linking each row to its own event.

For more information, see the following:

« Triggers Tab Definitions on Page 33
« Triggers Tab Tasks on Page 33

Figure 7: OTIS Elevator System Editor — Triggers Tab
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Triggers Tab Definitions

The OTIS Elevator System Editor — Triggers tab fields and buttons are described in Table 4 on Page 33

Table 4: OTIS Elevator System Editor Dialog Box—Triggers Tab Definitions

Field/Button | Description

Elevators System.
» BackupCommunicationStatus- The current Communications Status of Server B Controller
+ CommunicationStatus - The current Communications Status of Server A Controller

Click the Property to select it and add it to the column.

Add Click this button to create a new row in the Triggers table. You must configure all fields in the row to complete the Add operation.
Remove Click this button to remove a selected row from the Triggers table.
Property

Click in the Property column, and then click E] The Property browser opens presenting properties available for the OTIS

Value Selections are Online and Offline.

receives the selected Value.

Action Click the drop-down menu to select an action to occur. This action selected will occur when the object's selected Property

Details The name of the event configured for the row (read-only) entered by the system.

Event

9000 Configuration pane. See the CCURE 9000 Software Configuration Guide for more information.

Click the selection button [z] to select a Event that you want to associate with the trigger. Events are created in the C<CURE

Triggers Tab Tasks
The following tasks are performed in the Triggers tab:

« Selecting Triggers to Activate Events on Page 33

« Deleting Triggers and Events on Page 34

Selecting Triggers to Activate Events

|
To Select Triggers to Activate Events

1. Click the Triggers tab.
2. Click the Add button.

3. Click in the blank row under Property, and then click the selection button E] to open the OTIS Elevator System

dialog box.

Click in the blank field under Value.

Click the drop-down menu and select Offline or Online.

N o o k&

Click the drop-down menu under Action and select Activate Event.

The Event field appears at the bottom of the dialog box.

Click BackupCommunicationStatus (for Server B) or CommunicationStatus (for Server A) to select it.



8. Click the selection button [I]

9. Click a pre-configured event to activate.

10. Click Save and Close.

Deleting Triggers and Events

|
To Delete a Trigger and Event from the Elevator Group

1. Click the row selector button to select the row.

2. Click the Remove button.



Status Tab

The Status tab, shown in Figure 8 on Page 35, provides read-only information about the operational status of Server A
(primary server) and Server B (backup server) used by the OTIS Elevator system.

Supported values are:
m Online
m Offline

m Unknown

For more information, see the following:

m Status Tab Descriptions on Page 35

Figure 8: OTIS Elevator System Editor — Status Tab
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Status Tab Descriptions

The OTIS Elevator System Editor—Status tab fields are described in Table 5 on Page 36.



Table 5: Status Tab Definitions
- |

Field/Button Description

Server ACommunication Status Value (Status):

* Online: The OTIS Elevator System is configured and communicating with the primary OTIS
server (Server A).

» Offline: The OTIS Elevator System is configured, but not communicating with the primary
OTIS server (Server A).

* Unknown: The status cannot be determined, usually displayed after the initial OTIS Elevator
System configuration while waiting for the primary OTIS server (Server A) to update the
status.

Server B Communication Status Value (Status):

* Online: The OTIS Elevator System is configured and communicating with the secondary
OTIS server (Server B).

« Offline: The OTIS Elevator System is configured, but not communicating with the secondary
OTIS server (Server B).

* Unknown: The status cannot be determined, usually displayed after the initial OTIS Elevator
System configuration while waiting for the secondary OTIS server (Server B) to update the
status.




Override Tab

The Override tab, shown in Figure 9 on Page 37, is used to select a pre-configured personnel group that will be exempt
from the manual secure landing action. The selected exempt personnel group allows the personnel in the group access to
the landing when it is in the secured state.
For more information, see the following:

m Override Tab Definition on Page 37

m Selecting an Exempt Personnel Group on Page 38

Figure 9: OTIS Elevator System Editor - Override Tab
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Override Tab Definition

Table 6 on Page 37 describes the Override tab field.
Table 6: OTIS Elevator System Override Tab Dialog Box Definitions

Field Description

Exemption Group . . .
Click the selection button to select the pre-configured personnel group. See the C*CURE 9000 Software
Configuration Guide for information on creating personnel groups.




Selecting an Exempt Personnel Group

|
To Select n Exempt Personnel Group

1. Click the Override tab.

2. Click the selection button E] locate to the right of Exemption Group. The Group selection box opens.
3. Click inthe row below the Name column.

4. Click the drop-down arrow to select the exempt personnel group.

5

. Click Save and Close to save the configuration.



State Images Tab

The State Images tab, shown in Figure 10 on Page 39 displays the current elevator system images that display in the
Monitoring Station to represent activities concerning the elevator system. You can select other images to display for this
elevator system or return back to the default images, as described in this section.

See State Images Tab Tasks on Page 70 for information about changing the state images.

Figure 10: OTIS Elevator System Editor — State Images Tab
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State Images Tab Tasks

The following tasks are performed in the State Images tab:
m Replace a State Image on Page 39

m Restore the Default State Image on Page 40

Replace a State Image

e
To Replace an Image

1. Double-click the default image in the tab to open a Windows file selection dialog box.
2. If necessary, navigate to find the new image.

3. Select the desired replacement image and click Open.



The new image replaces the default image and displays in the State Images tab.

Restore the Default State Image

|
To Restore the Default Image

m Right-click the image in the State Images tab and select Restore Default.



Installation

This chapter explains how to install the OTIS Elevator System Integration. It also explains how to uninstall OTIS Elevator
System Integration.

In this chapter
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OTIS Configuration File . ... 51

UNINS Al 53



Installation Overview

The C-CURE 9000 software must be installed before the OTIS Elevator integration software is installed. For information
oninstalling C*CURE 9000, see the C-CURE 9000 Installation and Upgrade Guide.

Similar to the C<CURE 9000 system, the OTIS Elevator Integration has client and server components. You must install
the client components on every computer that runs C<CURE 9000 client applications, and you must install the server
components on the C<CURE 9000 server computer. The OTIS Elevator Integration has the same hardware, software,
and disk space requirements as CCURE 9000; if the target computer meets the requirements for the C<CURE 9000,
then it meets the OTIS Elevator Integration requirements.

The installation wizard prompts you to install the OTIS Elevator Integration software. You must perform the basic
installation process on each computer in your C«CURE 9000 security system. Be sure to close all C+.CURE 9000 and
virus--checking applications on client workstations before performing the installation.

Table 7 on Page 42 provides an overview of the steps to install and register the OTIS Elevator System on each computer
in your C<CURE 9000 security system.

Table 7: Installation Tasks Overview

Task See...
1. Install C-CURE 9000, if not already installed. C-CURE 9000 Installation and
Upgrade Guide

2. Ensure that the Pre-installation requirements are met. Before You Begin on Page 43

3. Installthe OTIS Elevator System Integration software. Installation on Page 44

4. Ifyoudid not select to start the C<CURE 9000 services during the installation, start the C<CURE 9000 Installation on Page 44
services and the OTIS Elevator Driver Service.

5. Verify thatalicense exists for the OTIS Elevator System. Licensing on Page 49

Table 8 on Page 42 provides the installation information on a MAS (Master Application Server) and SAS (Satellite
Application Server) environment.

Table 8: Installation on a MAS/SAS

Installationon a .... Installs...

MAS (Master Application Server) Nothing is installed.

Installation on a MAS is not supported.

MAS remote client and any other client systems * Onlythe OTIS Elevator System client objects are installed.

* No server or database objects are installed.

SAS (Satellite Application Server) All OTIS Elevator System components and the database are installed.

SAS remote client and any other client system * Onlythe OTIS Elevator System client objects are installed.

» No server or database objects are installed.




Before You Begin

You should perform the following pre-installation steps described below:

Pre-installation Steps

m If you are installing OTIS Elevator System Integration on a corporate network, be sure to coordinate with your
corporate network administrator.

m To perform the installation, you must have the appropriate Window's permissions. You must be in the local
Administrators group, or have equivalent privileges. See the Microsoft Operating System documentation or your
system administrator for more information.

m Ensure that you have two NIC (Network Interface Card) cards on the system
* One NIC to communicate with the Access Control System

* One NIC to communicate with the OTIS Elevator system.



Installation

|
To Install the OTIS Elevator Integration

1. Loginto the Server or Client with Administration privileges.
Map to a shared drive over the network.

Go to www.support.swhouse.com.

Select Products and then select Integrations.
Click Software Downloads.

Click Elevator and scroll down to Otis Elevator.

S L T R

Download the OTIS Integration software to a folder on the shared drive.

Running the Setup Program

|
To Run the Installation Program

Before installing the OTIS Elevator Integration, follow the below steps:
1. Close the C-CURE 9000 Administration Station and Monitoring Station.
2. Open the C<CURE 9000 Server Configuration Application and stop the following server services:

NOTE

o CrossFire Framework Service
o CrossFire Server Component Framework Service
3. Close the C-CURE 9000 Server Configuration Application.

1. Navigate to the folder where you downloaded the OTIS integration software.
Extract the OTIS integration files from the zip file you downloaded to a directory.

Click Release folder

> 0N

Right-click OTIS Integration.exe and select Run as Administrator.

The OTIS Integration Setup dialog box, shown in Figure 11 on Page 45, opens.


https://support.swhouse.com/#/login?return=%2Fhome

Figure 11: OTIS Integration Setup Dialog Box
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5. Click the |l accept the terms in the license agreement check box, and then click Install

The Tyco CrossFire Service Alert dialog box, shown in Figure 12 on Page 45, appears if you are installing the OTIS
Elevator System Integration on a C*CURE 9000 server and the CrossFire service is running.

When the CrossFire services are stopped the Tyco CrossFire Service Alert dialog box does not appear.

Figure 12: Preparing to Install Dialog Box
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6. Click OK to continue with the installation.
The OTIS Integration Setup Wizard, shown in Figure 13 on Page 46 appears.



Figure 13: OTIS Integration Setup Wizard

OTIS Integration Setup _ [C]x]

Welcome to the OTIS Integration Setup
Wizard
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7. Click Next to select the Installation Options, shown in Figure 14 on Page 46.

8. If you are installing the driver in a redundancy environment, then select the Redundant server installation using

supported third party redundancy option and the enter the Virtual server (alias) name of the Redundant
Environment.

Figure 14: Installation Options
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9. Click Next.
The Ready to Install OTIS Integration dialog box, shown in Figure 15 on Page 47, appears.



Figure 15: Database Server Dialog Box
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10. Click Install to start the installation or click Back to change the installation settings. Once installation is completed,
Completed the OTIS Integration Setup Wizard, shown in Figure 16 on Page 47, appears. This operation may take a
few minutes.

Figure 16: Completed the OTIS Integration Setup Wizard
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11. Click Finish to exit the Setup Wizard.
The Setup Successful dialog box, as shown in Figure 17 on Page 48, opens.




Figure 17: Setup Successful dialog box
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12. Click Close to exit the OTIS Installation.

NOTE

If you did not select the installation option to provide the virtual server (alias) name, or
provided the wrong alias name, for the redundancy environment:

1. Open the OTISElevatorDriverService.exe.config file located at the path
...ITycolCrossFire/ServerComponents (if you have upgraded the C-CURE from
previous version) else go to the folder .../JCI/CrossFire/ServerComponents (if you
have installed fresh C:.CURE 3.10).
2.

Under the client section in the file, change ‘localhost’ to the alias name of the redundant

environment for all the endpoint names except for the endpoint
name="TraceViewerURI".”



Licensing

You need a license to use the C*CURE 9000 OTIS Elevator Integration software. For more information, contact your local
Software House Sales Representative.

|
To Verify that you have an OTIS License

1. Double-click the Licensing icon on your desktop to open the C*CURE 9000 License dialog box.
(Alternately, you can select All Programs>Software House>Licensing.)

2. Click the Options tab.
3. Scroll down the list to verify that Otis Elevator Destination Dispatching System is listed.



Starting the Server Services

Before you can configure the OTIS Elevator integration object, the CrossFire Framework Service, CrossFire Server
Component Framework Service, and the OTIS Elevator Driver Integration Service must be running.

|
To Start the Server Services

1.

NOTE

From the Start Menu, select Start>All Programs>Tyco>C+CURE 9000>Server Configuration. The Server
Configuration Application opens.

Click the Services tab.
If the Status is displayed as “Stopped” for the CrossFire Framework Service under Framework Services, click Start.

If the Status is displayed as “Stopped” for the CrossFire Server Component Framework Service under Framework
Services, click Start.

Wait until the CrossFire Framework Service and CrossFire Server Component Service display a status of “Running”.

If the Status is displayed as “Stopped” for the OTIS Driver Service under Extension Services, click in the Enabled
check box and then click Start.

When the status of the OTIS Driver Service changes to Running you can use the OTIS Elevator System Integration
software.

When the OTIS Driver Service is stopped manually, it is recommended to start the service again aftera
minimum of 2 minutes duration is elapsed.



OTIS Configuration File

The OTIS configuration file is located at:
m For afresh C*CURE 3.10 server installation, path is: ...JCI\CrossFire\ServerComponents
m For an upgraded C<CURE 3.10 server, path is: ...Tyco\CrossFire\ServerComponents

This section describes the values that you can change in the OTIS configuration file:

NOTE If you make any changes in the configuration file you must restart the driver.

Ensure that you change the values only after consulting with the product support team.

SSIpAddress — This is the local IP Address of Security System (SS).
MulticastipAddress - This is the Multicast Group IP address.

SSReceiveUnicastPortNumberdmDES — This is the port number of SS at which SS receives Unicast messages from
DES. The default port number is 45303.

SSSendUnicastPortNumber2DES - This is the port number of DES at which SS sends Unicast messages to DES. The
default port number is 46303.

SSReceiveMulticastPortNumberdmDES - This is the port number of SS at which SS receives Multicast message from
DES for the V2 protocol. The default port number is 47307.

DESMulticastPortNumber - This is the port number of DES at which SS sends Multicast messages to DES for the V2
protocol. The default port number is 48307.

SSReceiveMulticastPortNumberdmDESV1 - This is the port number of SS at which SS receives Multicast messages
from DES for the V1 protocol. The default port number is 45307.

DESMulticastPortNumberV1 - This is the port number of DES at which SS sends Multicast messages to DES for V1
protocol. The default port number is 46307.

SSReceiveUnicastPortNumberdmDEC - This is the port number of SS at which SS receives Unicast messages from
DEC. The default port number is 46308.

SSSendUnicastPortNumber2DEC - This is the port number of DES at which SS sends Unicast message to DEC. The
default port number is 45308.

SSReceiveUnicastHeartbeatPortNumberdmDES - This is the port number of SS at which SS receives Unicast
Heartbeat message from DES for ICD versions 2.2/3.1. The default Port number is 53307.

DESUnicastHeartbeatPortNumber - This is the port number of DES at which SS sends Unicast Heartbeat message to
DES for ICD versions 2.2/3.1 . The default Port number is 54307.

RetryTimeOutMilliseconds - Use this variable to specify the duration between the retries. The default value is 1000
milliseconds.

NumberOfRetries - Use this variable to specify the number of times a message must be retried. The default value is 3.

ESHeartbeatintervalinMiliseconds — Use this variable to define the regular intervals, in milliseconds, to send a
HeartBeat. The default value is 1000 milliseconds.



HBOfflineChkRetrylnterval - Use this configuration to specify the duration that is used for setting the communication
status of the elevator server. It must be less than the 'HeartBeatTimeOut' configuration value. The default value is 2000
milliseconds.

HeartBeatTimeOut - Use this configuration to specify the timeout value for the Heartbeat, which would be compared with
the last successful Hearbeat received time from Elevator server to driver, to set the communication status of the elevator
server. The default value is 5000 milliseconds.

TTL - Use this variable to specify the time to live value for Heartbeat. The default value is 5.



Uninstall

This section describes how to uninstall the OTIS Elevator System integration on a Windows 7 operating system. For
additional operating systems, refer to your Microsoft Windows documentation for instructions to access the Add and
Remove programs.

|
To Uninstall the OTIS Elevator System

1.
2.

o ok~ w

Close the C-CURE 9000 Administration Workstation and the Monitoring Station.

Open the C-CURE 9000 Server Configuration Application, and stop the following server services:
« CrossFire Framework Service
« CrossFire Server Component Framework Service
« OTIS Driver Service

Close the C-CURE 9000 Server Configuration Application.

Open the Windows Control Panel.

Select Programs and Features.
Right-click C:.CURE 9000 - OTIS Elevator Integration and select Uninstall.
The C<CURE 9000 OTIS Integration Setup Wizard dialog box opens.

Click Next. The OTIS Integration Setup dialog box opens. This setup wizard allows you to remove the OTIS
Integration.

8. Click Next. Ready to remove OTIS Integration dialog box appears.

9. Click Remove to remove OTIS Integration.

10.

11.
12.

(Optional) Click in the Drop the OTIS Integration database tables check box to remove the OTIS tables from the
database. Completed the OTIS Integration Setup Wizard appears.

Click Finish. Setup Successful dialog box appears.

Click Close to complete the uninstallation process.



Cloud Connectivity and Support

This chapter explains about requirements and setup guidelines for preparing, configuring Airwall hardware, overlay, and
underlay Networks.

In this chapter:

Cloud connectivity and support for OTIS elevator driver __ ..l 55



Cloud connectivity and support for OTIS elevator driver

OTIS elevator driver supports in cloud environment secured by Airwall zero-trust network policy.

Environment prerequisites
1. Preprovisioned Airwall hardware in conductor

All Airwall devices must be preprovisioned and visible in the Airwall Conductor before deployment. This
ensures that each device is correctly registered and ready for secure communication within the zero-trust
network.

2. Overlay and underlay networks

Your environment must include properly configured underlay and overlay networks that support Airwall
hardware and all required C<CURE field devices, such as iSTAR controllers and elevator hardware.

» Underlay network: Provides the base connectivity within your WAN.

» Overlay network: Establishes a secure, encrypted communication path between on- premises devices and the
C+CURE cloud environment.

Airwall provisioning

In an Airwall secured zero-trust environment, communication between the C«CURE cloud machine and field devices
(elevator hardware, iISTAR controllers, etc.) requires that all Airwall hardware be properly preprovisioned and configured in
conductor by the Professional Services team.

Overlay & underlay network setup

Successful provisioning of Airwall hardware in conductor requires an appropriate underlay network within your WAN. This
forms the foundational routing and IP reachability required for Airwall devices to come online.

After device provisioning, you must use the overlay network to establish secure communication between the cloud and
on-premise devices. This overlay network enables encrypted, policy controlled traffic flow between all hardware and cloud
applications.

OTIS environment for cloud support

The OTIS setup for cloud environments can follow the same principles as the on-premises OTIS deployment. However, it
is strongly recommended to implement the overlay and underlay network configuration as directed by the Professional
Services team. For detailed guidance on network architecture and configuration, refer to the relevant C<CURE
documentation.

During cloud validation testing, an average latency of approximately 300 milliseconds was observed in the Airwall
secured network. The responsiveness of elevator card swipes and landing matrix dispatch operations is directly
correlated with the performance of the Airwall network. Additionally, when the network becomes unavailable, all elevator
devices were observed to lose communication temporarily, and they automatically return online once network
connectivity is restored.



Guidance and support (for Airwall provisioning and network configuration)

For Airwall provisioning enquiries, including device onboarding, Conductor configuration, Zero-Trust setup, and underlay
or overlay network design, contact the Professional Services or Support teams. These teams ensure that all Airwall
components and network layers are implemented securely and according to best practices, enabling reliable
communication between cloud services and on-premises field hardware.



OTIS Default Landing Matrix Configuration

This chapter describes how to configure a default landing using the OTIS Default Landing Matrix dialog box.

In this chapter
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OTIS Default Landing Matrix Dialog BoX .. ...l 59



Accessing the OTIS Default Landing Matrix Dialog Box

This section describes how to access the OTIS Default Landing Matrix dialog box.

To Access the Dialog Box

1. Openthe C-CURE 9000 Administration Station.

2. Click the Hardware Pane.

3. Click the Hardware drop-down menu and select Hardware Folder.
4

Right-click the OTIS Elevator System folder and select OTIS Default Landing Matrix>New, as shown in Figure 18
on Page 58.

(Alternately, you can right-click the OTIS Default Landing Matrix icon and select New.)
Figure 18: Accessthe OTIS Default Landing Matrix Dialog Box
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The OTIS Default Landing Matrix dialog box, as shown in Figure 19 on Page 59, opens.



OTIS Default Landing Matrix Dialog Box

Landing Matrix is a collection of landing (floors) that an OTIS elevator system supports. OTIS has two types of Landing
Matrices. Default Landing Matrix and Clearance Default Landing Matrix. The OTIS Default Landing Matrix dialog box,
shown in Figure 19 on Page 59, is used to configure a common access Landing Matrix with no personnel clearances.

NOTE You must create a landing in C*CURE, in-order to dispatch the Landing matrix.

For more information, see the following:
m Accessing the OTIS Default Landing Matrix Dialog Box on Page 58
m OTIS Default Landing Matrix Dialog Box Definitions on Page 59
m OTIS Default Landing Matrix Tasks on Page 60

Figure 19: OTIS Default Landing Matrix Dialog Box
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OTIS Default Landing Matrix Dialog Box Definitions

The OTIS Default Landing Matrix dialog box fields and buttons are described in Table 9 on Page 60.



Table 9: OTIS Elevator System Default Landing Dialog Box Definitions
|

Field/Button | Description

Name Aunique name identifying the default landing matrix configuration.
* The name is not case-sensitive
* Minimum number of characters: 1

* Maximum number of characters: 100

Description Optional. A description for the default landing matrix configuration.
* The description is not case-sensitive.
*  Minimum number of characters: None

* Maximum number of characters: 500

Save and Saves the configuration and closes the dialog box.

Close

Front

Landing Select the front doors of the floors to be included in the configuration.
Matrix

» Checked indicates selected.
» Unchecked indicates not selected.

Valid range is between -127 to 127

Rear
Landing Select the rear doors of the floors to be included in the configuration.
Matrix » Checked indicates selected.
* Unchecked indicates not selected.
Valid range is between -127 to 127.
For ICD Version V1.0, Rear floor selection is not supported.
NOTE !

OTIS Default Landing Matrix Tasks

This section describes the following tasks.
m Creating a Default Landing Matrix on Page 60
m Editing a Default Landing Matrix Configuration on Page 61
m Viewing Default Landing Matrix Configurations on Page 61
m Creating a Default Landing Matrix Template on Page 61

m Deleting a Default Landing Matrix Configuration on Page 62

Creating a Default Landing Matrix

|
To Create a Default Landing Matrix

1. Right-click the OTIS Elevator System folder in the Hardware tree and select OTIS Default Landing Matrix>New.



5.

(Alternately, you can select OTIS Default Landing Matrix from the Hardware drop-down menu, and then click the
New icon.

Enter a name for the default landing matrix in the Name field.
Enter a description (optional) for the default landing matrix in the Description field.

Click in the check boxes next to the floors that you want to include in the default landing matrix. For front door, use the
Front tab. Similarly for the rear door, use the Rear tab.

Click Save and Close when done.

The default landing matrix is listed under OTIS Default Landing Matrix in the tree under the OTIS Elevator System
folder.

Editing a Default Landing Matrix Configuration

|
To Edit a Default Landing Matrix Configuration

1.
2.
3.

Click the arrow located to the left of the OTIS Elevator System folder.
Click the arrow located to the left of OTIS Default Landing Matrix icon.

Right-click the default landing matrix that you want to edit and select Edit from the context menu.

(Alternately, you can double-click the OTIS Default Landing Matrix icon to open a Dynamic View displaying OTIS
Default Landing Matrix configurations. Then, either double-click the default landing matrix or right-click the default
landing matrix that you want to edit to open the OTIS default Landing Matrix dialog box.)

The OTIS Default Landing Matrix dialog box opens.
Make your changes to the configuration.

Click Save and Close.

Viewing Default Landing Matrix Configurations

Default Landing Matrix configurations are viewed in the Dynamic View.

|
To View Default Landing Matrix Configurations

1.

Double-click the OTIS Default Landing Matrix icon under the OTIS Elevator System folder.

Default Landing Matrix configurations are displayed in the OTIS Default Landing Matrix tab in the Dynamic View.

Creating a Default Landing Matrix Template

|
To Create a Default Landing Template

1.

Right-click the OTIS Elevator System folder and select OTIS Default Landing Matrix>New Template.
(Alternately, you can right-click the OTIS Default Landing Matrix icon and select New Template.)
Enter a name for the template in the Name field.

Enter a description (optional) in the Description field.

Click in the check boxes next to the floors that you want to include in the default landing matrix template. For front
door, use the Front tab. Similarly for the rear door, use the Rear tab.



5. Click Save and Close when done.

The new template is listed under OTIS Default Landing Matrix>Templates.

Deleting a Default Landing Matrix Configuration

You cannot delete a Default Landing Matrix if there are DEC configurations associated with

NOTE the Default Landing Matrix. You must delete the DEC configurations before you can delete
the Default Landing Matrix.
|

To Delete a Default Landing Matrix Configuration

1. Click the arrow located to the left of the OTIS Elevator System folder.

2. Click the arrow located to the left of the OTIS Default Landing Matrix.

3. Right-click the default landing matrix that you want to delete and select Delete.
(Alternately, you can right-click a default landing matrix configuration in the Dynamic View and select Delete.)
The Deleting OTIS Default Landing Matrix objects dialog box opens.

4. Click Yes to confirm the deletion.
The object is deleted.

5. Click OK to confirm that the object was deleted.



OTIS Landing Configuration

This chapter describes how to configure a landing (floor) using the OTIS Landing dialog box.

In this chapter

Accessing the OTIS Landing Dialog BoX .. .. il 64
OTIS Landing Dialog BoX ... il 65
Landing Dialog Box - Override Tab ... ... . 68
Landing Dialog Box - State Images Tab ... o e 69

OTIS Landing Manual ACtioNs . ... . 7



Accessing the OTIS Landing Dialog Box

The OTIS Landing dialog box is used to identify a Landing index to be used by the Elevator System.

NOTE The OTIS Elevator System must be configured before you can access this dialog box. See
OTIS Elevator System Editor Dialog BoxChapter 2, OTIS Elevator System Configuration for
more information.

To Access the OTIS Landing Dialog Box

1. Right-click the elevator system icon under the OTIS Elevator System folder in the Hardware tree, and select
OTIS Landing>New, as shown in Figure 20 on Page 64.

Figure 20: Accessthe OTIS Landing Dialog Box
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The OTIS Landing dialog box, shown in Figure 21 on Page 65, opens.



OTIS Landing Dialog Box

The OTIS Landing dialog box, shown in Figure 21 on Page 65, lets you create a landing (floor) to be used by the Elevator
System.

For more information, see the following:
m Accessing the OTIS Landing Dialog Box on Page 64
m OTIS Landing Dialog Box Definitions on Page 65
m OTIS Landing Dialog Box Tasks on Page 66

Figure 21: OTIS Landing Dialog Box
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OTIS Landing Dialog Box Definitions
Table 10 on Page 65 describes the OTIS Landing dialog box fields and buttons.

Table 10: OTIS Elevator System Landing Dialog Box Definitions
|

Field/Button Description

Name The Landing Index value you enter appears in the Name field.
* The name is not case-sensitive
Minimum number of characters: 1

Maximum number of characters: 100




Table 10: OTIS Elevator System Landing Dialog Box Definitions (continued)

Field/Button Description

Description Optional. Enter a description for the landing.
* Thedescription is not case-sensitive.
*  Minimum number of characters: None

* Maximum number of characters: 500

Save and Close Saves the configuration and closes the dialog box

General Tab

Elevator System The name of the OTIS Elevator System. This field is read-only.

Landing Index (Floor Landing index is the index associated with the Landing. The value is between -127 to 127.

Number)

DEC Map NOTE: The following read-only information is not available until the DEC Configuration is complete.

+ DECID - The unique identifier for the DEC
+ DEC Name - The name of the configured DEC.
» Door Name — The name of the assigned door.

Override Status Tab

Override Status Displays the override status of the floor object. This field is read-only.

The three override statutes are: Secure, Unsecure, and Normal.

OTIS Landing Dialog Box Tasks

This section describes the following tasks:
m Creating a Landing Configuration on Page 66
m Editing a Landing Configuration on Page 67
m Viewing Landing Configurations on Page 67

m Deleting a Landing Configuration on Page 67

Creating a Landing Configuration

e
To Create a Landing Configuration

1. Right-click the Elevator System in the tree and select OTIS Landing>New.
2. Enter aname for the landing in the Name field.

3. Enteradescription (optional) in the Description field for the Landing Index.
4. Click Save and Close.
5

Go to OTIS DEC Clearance Landing Matrix Dialog Box on Page 77 to configure the clearance for the landing.



Editing a Landing Configuration

|
To Edit a Landing Configuration

1. Double-click the Landing configuration in the tree that you want to edit.
(Alternately, you can right-click the landing configuration in the tree and select Edit from the context menu.)
2. Make the changes to the configuration.

3. Click Save and Close.

Viewing Landing Configurations

|
To View Landing Configurations

1. Select OTIS Landing from the Hardware drop-down menu.

2. Click the green right arrow E to open a Dynamic View displaying all Landings.

The OTIS Landing tab opens in the Dynamic View displaying a list of OTIS Landing configurations.

Deleting a Landing Configuration

You cannot delete a landing if there are DEC configurations associated with the landing. You
must delete the DEC configurations before you can delete the landing.

NOTE
|
To Delete a Landing Configuration

1. Right-click the Landing configuration that you want to delete and select Delete from the context menu.

(Alternately, you can select OTIS Landing from the Hardware drop-down menu and click the green right arrow & to
open a Dynamic View displaying all Landings.)

The Deleting OTIS Landing objects dialog box opens.
2. Click Yes to confirm the deletion.

The object is deleted.
3. Click OK to confirm that the object was deleted.

OTIS Landing Dialog Box Tabs

The following sections provide information about the OTIS Landing dialog box tabs:
m Landing Dialog Box - Override Tab on Page 68
m Landing Dialog Box - State Images Tab on Page 69



Landing Dialog Box - Override Tab

The Override tab, shown in Figure 22 on Page 68, provides read-only information about override status of the landing for
which manual action is performed. For a landing, the Override Status can be, Secure, Unsecure or Normal.

Figure 22: Landing Dialog Box - Override Tab
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Landing Dialog Box - State Images Tab

The State Images tab , shown in Figure 23 on Page 69 displays the current elevator system images that display in the
Monitoring Station to represent the manual action activities concerning the elevator system. You can select other images
to display for this elevator system and return back to the default images, as described in this section.

Table 11: OTIS Landing Dialog Box State Images Tab- Descriptions

State Image | Description
E Normal
H Secure

Tl Unsecure

For information about manual actions, see OTIS Landing Manual Actions on Page 71.
Figure 23: Landing Dialog Box - State Images Tab
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State Images Tab Tasks

The following tasks are performed in the State Images tab:
m Replace a State Image on Page 70

m Restore the Default State Image on Page 70

Replace a State Image

|
To Replace an Image

1. Double-click the default image in the tab to open a Windows file selection dialog box.
2. If necessary, navigate to find the new image.

3. Select the desired replacement image and click Open.

The new image replaces the default image and displays in the State Images tab.

Restore the Default State Image

|
To Restore the Default Image

m Right-click the image in the State Images tab and select Restore Default.



OTIS Landing Manual Actions

A Manual Action is a specific type of action that the operator can perform on objects in the system. Manual Actions are
those actions that open a Manual Action dialog box, and the actions are also logged in the Activity Viewer as “Manual
Event by Operator Name,” along with the Name of the action, Name of the Event, Partition, date and time. Completed
Manual actions are logged in the Activity Viewer.

OTIS Landing Manual Actions are Secure Landing and Un-secure Landing.

For more information, see the following:
m Accessing OTIS Landing Manual Actions on Page 71
m Using Manual Actions to Secure a Landing on Page 72
m Using Manual Actions to Un-Secure a Landing on Page 73

m Canceling Manual Actions on Page 131

For information about configuring OTIS events and actions, see OTIS Events on Page 125.

Accessing OTIS Landing Manual Actions

NOTE The Landing (OTIS Landing Dialog Box on Page 65) must be configured before you can
secure or un-secure a landing.

|
To Access the OTIS Landing Manual Actions

1. Click the OTIS Elevator System folder in the Hardware tree.
2. Right-click the OTIS Landing that you want to perform the Manual Action.

The Manual Action selections are Secure Landing and Un-Secure Landing as shown in Figure 24 on Page 72.



Figure 24: Accessing the OTIS Landing Manual Actions

Hardware
ﬂ' - IO’I‘IS Landing j - |
Hardware Tree Search

4 Hardware
i[53 Digital Certificates
4 [ CompanyName
[ Em apC Comm Ports

i Wl APC_Test
Fl m Elevator_1
[> ﬂ_ L I el
» By isTA & et
i[5 Unassig| X Delete
M Set property
.% Add to group
Find in Audit Log...
Find in Journal...

Secure Landing. ..

& Card Format

Un-Secure Landing. .. .
' Video .
@ OTIS DEC ’
Configuration
iy Hardware

. ¥

Using Manual Actions to Secure a Landing
This action secures the Landing. There is no access to the Landing during the date and time value set, except the
personnel in the Exemption Group list.

|
To Secure a Landing

1. Right-click the Landing configuration that you want to secure and select Secure Landing from the context menu. The
Secure Landing dialog box opens.



Figure 25: OTIS Secure Landing Dialog Box
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2. Enterthe time and date to secure the Landing in the Start field, or click |T| to use the calendar controls to set the date.

3. Enter the time and date to un-secure the Landing in the End field, or click |T| to use the calendar controls to set the
date.

4. Select the Priority. This field indicates the priority level the system uses for sorting when displaying on the
Monitoring Station and prioritizing actions associated with the event. The default priority is 75, Medium Low. Select a
value from the drop-down list or type an integer from 0 to 200 to assign a priority to the Event. The lowest value is 0;

the highest is 200.
5. Select the Time Zone for the secure and un-secure times.

6. Enter a note for future reference in the Instructions field.

Using Manual Actions to Un-Secure a Landing

This action un-secures the Landing. Everyone will have access to the Landing during the date and time value set.

|
To Un-Secure a Landing

1. Right-click the Landing configuration that you want to un-secure and select Un-Secure Landing from the context
menu. The Un-Secure Landing dialog box opens.



Figure 26: OTIS Un-Secure Landing Dialog Box
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Enter the time and date to un-secure the Landing in the Start field, or click |7| to use the calendar controls to set the
date.

. Enter the time and date to end the un-secure Landing in the End field, or click |T| to use the calendar controls to set
the date.

. Select the Priority. This field indicates the priority level the system uses for sorting when displaying on the
Monitoring Station and prioritizing actions associated with the event. The default priority is 75, Medium Low. Select a
value from the drop-down list or type an integer from 0 to 200 to assign a priority to the Event. The lowest value is 0;
the highest is 200.

. Select the Time Zone for the secure and un-secure times.
Enter a note for future reference in the Instructions field.
Whenever the manual action (secure landing/un-secure landing) is triggered and in between OTIS

Elevator System integration restarts, the floor normal message is displayed first on the Monitoring station
and then manual action (secure landing/un-secure landing) message is displayed.

NOTE

NOTE Manual Action which is triggered last will be processed irrespective of the Priority set.



OTIS DEC Clearance Landing Matrix Configuration

This chapter describes to configure clearances using the OTIS DEC Clearance Landing Matrix dialog box.

In this chapter

Accessing the OTIS DEC Clearance Landing Matrix Dialog Box ... ... ... 76
OTIS DEC Clearance Landing Matrix Dialog BoX ... ... . 77



Accessing the OTIS DEC Clearance Landing Matrix Dialog Box

This section describes how to access the OTIS DEC Clearance Landing Matrix dialog box.

To Access the Dialog Box

1. Right-click the elevator system icon under the OTIS Elevator System folder and select OTIS Clearance Landing
Matrix>New, as shown in Figure 27 on Page 76.

Figure 27: Accessthe OTIS DEC Clearance Landing Matrix Dialog Box
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The OTIS Clearance Landing Matrix dialog box, as shown in Figure 28 on Page 77, opens.



OTIS DEC Clearance Landing Matrix Dialog Box

The OTIS DEC Clearance Landing Matrix dialog box, shown in Figure 28 on Page 77, is used to define up to 127 front and
127 rear doors that can be accessed by cardholders that have a clearance associated with the landing matrix. For
ICD Version 1.0 the DEC Clearance Landing Matrix dialog box is shown in Figure 29 on Page 78.

For more information, see the following:
m Accessing the OTIS DEC Clearance Landing Matrix Dialog Box on Page 76
m OTIS DEC Clearance Landing Matrix Dialog Box Definitions on Page 78

Figure 28: OTIS DEC Clearance Landing Matrix Dialog Box
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Figure 29: OTIS DEC Clearance Landing Matrix Dialog Box(For ICD Version 1.0)

OTIS DEC Clearance Landing Matrix - !E E

g Save and Close |

Name: ||

Description: ;l

General

Elevator System IEIevator_'I 1

Clearance Name I Ll
Home Floor In 3:

== Add = Remove

Landing Matrix

OTIS DEC Clearance Landing Matrix Dialog Box Definitions

Table 12 on Page 78 describes the OTIS DEC Clearance Landing Matrix dialog box fields and buttons.

Table 12: OTIS DEC Clearance Landing Dialog Box Definitions
|

Field/Button Description

Name The name of the DEC Clearance Landing Matrix
* The name is not case-sensitive
* Minimum number of characters: 1

* Maximum number of characters: 100

Description Optional. Enter a description for the DEC Clearance Landing Matrix .
» The description is not case-sensitive.
*  Minimum number of characters: None

* Maximum number of characters: 500




Table 12: OTIS DEC Clearance Landing Dialog Box Definitions (continued)

Field/Button Description

Save and Close Saves the configuration and closes the dialog box.

General Tab

Elevator System The name of the OTIS Elevator System. This field is read-only.

Clearance Name The pre-configured personnel clearance. This field is used to select the clearance that allows access to the Door with a
reader that a person swipes their card to get authorization to use the landing.

Note: Thisis a mandatoryfield. If you try to save the Clearance landing Matrix without mapping the Clearance, an
error message displays.

Home Floor Optional. The Home Floor is the default floor in OTIS and should be mapped to a clearance.
You can select the Home Floor from -127 to 127. You must select either Front or Rear door.
Note: Frontand Rear door selections are not applicable for ICD Version v1.0.

Note: This Home Floor should be selected in the landing matrix associated to Clearance Landing Matrix.

Landing Matrix Allows selection of a pre-configured Default Landing Matrix.

OTIS DEC Clearance Landing Matrix Dialog Box Tasks

This section describes the following tasks:
m Creating a DEC Clearance Landing Matrix on Page 79
m Viewing DEC Clearance Landing Matrix Configurations on Page 80
m Deleting a DEC Clearance Landing Matrix Configuration on Page 81

m Creating a DEC Clearance Landing Matrix Template on Page 81

Creating a DEC Clearance Landing Matrix

e
To Create a DEC Clearance Landing Matrix

1. Right-click the elevator system icon under the OTIS Elevator System folder in the Hardware tree and select OTIS
DEC Clearance Landing Matrix>New.

2. Enteraname, of up to 100 characters, for the clearance landing matrix in the Name field.

3. Enter adescription (optional) of up to 500 characters in the Description field.

4. Click the selection button B located to the right of the Clearance Name field to open the Clearance selection
dialog box.

5. Click a clearance to select it.
6. Optional Click the Landing Matrix tab.
7. Optional Click the Add button.

8. Optional Click the selection button E] in the empty row under Landing Matrix to open the OTIS Default Landing
Matrix selection box.



9. Optional Click a default landing matrix configuration to select it. The selection appears under Landing Matrix.

10. Click Save and Close when done.

Creating a DEC Clearance Landing Matrix with Home Floor

|
To Create a DEC Clearance Landing Matrix with Home Floor

1. Right-click the elevator system icon under the OTIS Elevator System folder in the Hardware tree and select OTIS
DEC Clearance Landing Matrix>New.

2. Enteraname, of up to 100 characters, for the clearance landing matrix in the Name field.

3. Enter adescription (optional) of up to 500 characters in the Description field.

4. Click the selection button E] located to the right of the Clearance Name field to open the Clearance selection
dialog box.

5. Click a clearance to select it.

6. Enter avalue, between -127 and 127, to identify Clearance Landing Matrix Home Floor. You must select either Front
or Rear.

7. Click Save and Close when done

Home Floor Configuration
Pre-Requisites:
« Landing for Home Floor should be created

« Default Landing Matrix should be created which should have Home Floor

« Home Floor should be part of created Default Landing Matrix

1. In Clearance landing matrix, add Home Floor.

NOTE

2. Under Landing Matrix tab, make sure to add Default Landing Matrix that has Home Floor selected.

3. Itis recommended to have only 1 Home Floor/Clearance Landing Matrix per person.

Viewing DEC Clearance Landing Matrix Configurations

|
To View DEC Clearance Landing Matrix Configurations

1. Click the Hardware drop-down menu and select OTIS DEC Clearance Landing Matrix.

2. Click the green right arrow & located to the right of the Hardware drop-down menu.

The OTIS DEC Clearance Landing Matrix tab opens in the Dynamic View displaying a list of DEC Clearance Landing
Matrix configurations.

Editing a DEC Clearance Landing Matrix Configuration

|
To Edit a DEC Clearance Landing Matrix Configuration

1. Click the Hardware drop-down menu and select OTIS DEC Clearance Landing Matrix.



2. Click the green right arrow & located to the right of the Hardware drop-down menu.

The OTIS DEC Clearance Landing Matrix tab opens in the Dynamic View displaying a list of DEC Clearance Landing
configurations.

3. Right-click the OTIS DEC Clearance Landing Matrix that you want to edit and select Edit from the context menu.

Alternately, you can double-click the DEC Clearance Landing Matrix configuration to open the OTIS DEC Clearance
Landing Matrix dialog box.

4. Make the changes to the configuration.

5. Click Save and Close.

Deleting a DEC Clearance Landing Matrix Configuration

|
To Delete a DEC Clearance Landing Matrix Configuration

1. Click the Hardware drop-down menu and select OTIS DEC Clearance Landing Matrix.

2. Click the green right arrow & located to the right of the Hardware drop-down menu.

The OTIS DEC Clearance Landing Matrix tab opens in the Dynamic View displaying a list of DEC Clearance Landing
configurations.

3. Right-click the OTIS DEC Clearance Landing Matrix configuration that you want to delete and select Delete from the
context menu.

The Deleting OTIS DEC Clearance Landing Matrix objects dialog box opens.
4. Click Yes to confirm the deletion.

The object is deleted.
5. Click OK to confirm that the object was deleted.

Creating a DEC Clearance Landing Matrix Template

|
To Create a DEC Clearance Landing Matrix Template

1. Right-click the elevator system icon under the OTIS Elevator System folder and select OTIS DEC Clearance
Landing Matrix>New Template.

2. Enter the information for the clearance landing matrix template.
3. Click Save and Close.

The new template is listed under OTIS DEC Clearance Landing Matrix>Templates.



OTIS DEC Configuration

This chapter describes to configure the DEC (Destination Entry Computer) using the OTIS DEC dialog box.

In this chapter

Accessing the DEC Dialog Box
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Accessing the DEC Dialog Box

This section explains how to access the OTIS DEC dialog box.

NOTE The OTIS Elevator System must be configured before you can access this dialog box. See
OTIS Elevator System Editor Dialog Box and OTIS Landing Dialog Box on Page 65 for more

information.

To Access the DEC Dialog Box

1. Click the elevator system icon under the OTIS Elevator System folder under the Hardware tree.

2. Right-click the Landing and select OTIS DEC>New, as shown in Figure 30 on Page 83.

Figure 30: Accessthe DEC Dialog Box

Help

> 53 Digital Certificates
4 [ CompanyName
[ B apC Comm Ports
1] 456456
- [l APC_Test
> [ iSTAR Cluster
4 [ OTIS Elevator

™4 = |OTIS Landing - =
Hardware Tree ] Search
4 Hardware

i+ [EE] OTIS Default Landing Matrix

=_je

.

’
e
=i

4 m Elevator_1
B Landing_
> B Unassi B Edt
K Delete
’G& Card Formats and Kd o]  Setproperty
& Add to group
Configuration
- Find in Audit Log...
{? i3 are Find in Journal...
@ Data Views Secure Landing...
m Personnel Un-Secure Landing. ..
OTIS DEC v

The OTIS DEC dialog box , shown inFigure 31 on Page 85 opens.



OTIS DEC Dialog Box

The OTIS DEC dialog box, shown in Figure 31 on Page 85, represents DEC present in the OTIS Elevator system. The
OTIS DEC dialog box lets you configure the DEC general information, including Door Name, IP address, enable Audit,
enable Pin, assign a pre-configured schedule and set operation mode.

For ICD Version 1.0 the DEC dialog box is shown in Figure 32 on Page 86.

NOTE The OTIS Elevator System (OTIS Elevator System Editor Dialog Box on Page 26), OTIS
Default Landing Matrix (OTIS Default Landing Matrix Dialog Box on Page 59) and the
OTIS Landing (OTIS Landing Dialog Box on Page 65) must be configured before you can
configure the DEC.

For more information, see the following:

m Accessing the DEC Dialog Box on Page 83

m DEC Dialog Box Definitions on Page 86

m OTIS DEC Dialog Box Tasks on Page 87

m OTIS DEC Dialog Box Tabs on Page 89



Figure 31: OTIS DEC Dialog Box (ICD versions 2,2.2, 3, and 3.1)
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Figure 32: OTIS DEC Dialog Box (ICD Version 1.0)
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DEC Dialog Box Definitions

Table 13 on Page 86 describes the OTIS DEC dialog box- General tab fields and buttons.

Table 13: OTIS DEC Dialog Box - General Tab Definitions
- |

Field/Button Description

Name Aunique name identifying the DEC configuration.
* The name is not case-sensitive
*  Minimum number of characters: 1

* Maximum number of characters: 100




Table 13: OTIS DEC Dialog Box - General Tab Definitions (continued)

Field/Button Description

Description Optional. A description for the DEC configuration.
« Thedescription is not case-sensitive.
* Minimum number of characters: None

* Maximum number of characters: 500

Save and Close Saves the configuration and closes the dialog box

General Tab

Elevator System The name of the OTIS Elevator System. This field is read-only.
Landing Name The name of the Landing. This field is read-only.
IP Address IP Address of the DEC. Enter the unique IP Address.

Enter the value in the fourth subnet. The first three subnet addresses are fixed, and the value range of fourth
subnet addressis from 1 to 240. The third subnet address is the same as the DER/DES’s third subnet address.

Enable Audit Enable (checked)indicates C*CURE 9000 will start receiving floor selection messages from the respective DEC.
Default: Disabled (unchecked)

NOTE: This check box is not applicable for ICD Version V1.0.

Enable PIN Enable (checked) indicates Pin entry is enabled at the respective DEC. When the Enable PIN check box is
selected, the DEC can accept or reject the Pin codes. For more information see, DEC Clearances Tab on Page
101.

Default: Disabled (unchecked)

NOTE: This check box is not applicable for ICD Version V1.0.

OTIS DEC Dialog Box Tasks

This section describes the following tasks:

Configuring a DEC on Page 87

Editing a DEC Configuration on Page 88
m Viewing All DEC Configurations on Page 89

Deleting a DEC Configuration on Page 89

Configuring a DEC

To Configure a DEC

1. Right-click the elevator system icon under the OTIS Elevator System folder in the Hardware tree and select
OTIS DEC>New.

The OTIS DEC dialog box opens.
2. Enter aname, of up to 100 characters, for the DEC in the Name field.

3. (Optional) Enter description for the DEC configuration in the Description field.



Enter the IP address for DEC. For each group ID of the Elevator System, DEC address vary from XXX.YYY.n.1 to
XXX.YYY.n.240.

5. (Optional) Select the Enable Audit or Enable PIN check box.

6. (Optional) In the Operation Modes section click the Edit button to change the Operation mode for this DEC in the
OTIS System. For more information on selecting the Operation Mode see Operation Mode Message.

7. Click Save and Close to save the configuration.

Selecting the Operation Mode

|
To Select the Operation Mode

1. Inthe Operation Modes section click the Edit button. A warning message appears as shown in the Figure 33.

Figure 33: Operation Mode Message
Opeartion Modes Message @

Edit the mode only if you are aware of necessary configurations
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QK l I Cancel

2. Click OK. DEC Operation Modes window opens to select the Operation Mode as shown in Figure 34 on Page 88.

Figure 34: DEC Operation Modes
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3. Select the Operation Mode and click Submit.

Editing a DEC Configuration

|
To Edit a DEC Configuration

1. Double-click the DEC configuration in the tree that you want to edit.
Alternately, you can right-click the DEC configuration in the tree and select Edit from the context menu.



2. Make the changes to the configuration.

3. Click Save and Close.

Viewing All DEC Configurations

To View All DEC Configurations
1. Click the Hardware drop-down menu and select OTIS DEC.

2. Click the green right arrow & located to the right of the Hardware drop-down menu.

The OTIS DEC tab opens in the Dynamic View displaying a list of OTIS DEC configurations.

Deleting a DEC Configuration

|
To Delete a DEC Configuration

1. Right-click the DEC configuration that you want to delete and select Delete from the context menu.
The Deleting OTIS DEC objects dialog box opens.

2. Click Yes to confirm the deletion.
The object is deleted.

3. Click OK to confirm that the object was deleted.

OTIS DEC Dialog Box Tabs

The following sections provide information about the OTIS DEC Dialog Box Tabs:
m DEC - Landing Matrix Tab on Page 90
m DEC - Schedule Matrix Tab on Page 92
m DEC Operation Modes Tab on Page 94
m DEC Triggers Tab on Page 96
m DEC Status Tab on Page 99
m DEC Clearances Tab on Page 101
m DEC Card Format Tab on Page 112
m DEC iStar Doors Tab on Page 114
m DEC State Images Tab on Page 116



DEC - Landing Matrix Tab

The OTIS DEC dialog box - Landing Matrix tab, shown in Figure 35 on Page 90, is used to assign a pre-configured default
landing matrix configuration to a DEC.

For more information, see the following:
m Landing Matrix Tab Definitions on Page 90
m Landing Matrix Tab Tasks on Page 91

Figure 35: OTIS DEC Dialog Box - Landing Matrix Tab
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Landing Matrix Tab Definitions

Table 14 on Page 90 describes the Landing Matrix tab fields and buttons.
Table 14: OTIS DEC Dialog Box - Landing Matrix Tab Definitions

Field/Button | Description

Add Adds an empty row to the table for selection of a default landing matrix configuration.




_______________________________________________________________________________________|
Field/Button | Description

Remove Removes and deletes the selected default landing matrix configuration from the table.

Landing Matrix | The defaultlanding matrix configuration selected.

Landing Matrix Tab Tasks
This section includes the following tasks:

m Configuring an OTIS Landing Matrix on Page 91
m Deleting an OTIS Landing Matrix on Page 91

Configuring an OTIS Landing Matrix

I
To Configure an OTIS Landing Matrix

1. Click the Landing Matrix tab.
2. Click the Add button.

3. Click the selection button [I] in the empty row under Landing Matrix to open the OTIS Default Landing Matrix
selection box.

4. Click a default landing matrix configuration to select it. The selection appears under Landing Matrix.

5. Click Save and Close.

Deleting an OTIS Landing Matrix

I
To Delete an OTIS Landing Matrix

1. Click in the row containing the default landing matrix you want to delete.

2. Click the Remove button.



DEC - Schedule Matrix Tab

The OTIS DEC dialog box - Schedule Matrix tab, shown in Figure 36 on Page 92, is used to assign a pre-configured
schedule to a pre-configured default landing matrix configuration.

For more information, see the following:

m Schedule Matrix Tab Definitions on Page 92

m Schedule Matrix Tab Tasks on Page 93

Figure 36: OTIS DEC Dialog Box- Schedule Matrix Tab
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Schedule Matrix Tab Definitions

Table 15 on Page 92 describes the Schedule Matrix tab fields and buttons.

Field/Button

Table 15: OTIS DEC Dialog Box - Schedule Matrix Tab Definitions

Description

Add

Adds an empty row to the table for selection of a default landing matrix configuration and to select a schedule to assign to it.

Remove

Removes and deletes the selected default landing matrix configuration and the assigned schedule from the table.




______________________________________________________________________________________________________________________|]
Field/Button | Description

Landing The default landing matrix configuration is selected.
Matrix
Schedule The schedule selected for the default landing matrix configuration. See the C*CURE 9000 Software Configuration Guide for

more information about configuring schedules.

Schedule Matrix Tab Tasks

This section includes the following tasks:
m Configuring an OTIS Landing Schedule Matrix on Page 93
m Deleting an OTIS Landing Schedule Matrix on Page 93

Configuring an OTIS Landing Schedule Matrix

Only seven Landing schedule matrices are supported fora DEC.

NOTE

I
To Configure an OTIS Landing Schedule Matrix

1. Click the Schedule Matrix tab.
2. Click the Add button.

3. Click the selection button B in the empty row under Landing Matrix to open the OTIS Default Landing Matrix
selection box.

4. Click a default landing matrix configuration to select it. The selection appears under Landing Matrix.

5. Click in blank field under Schedule, and then click the selection button E] The Schedule selection box opens.
6. Click a schedule to select it. The selection appears under Schedule.

7. Click Save and Close.

Deleting an OTIS Landing Schedule Matrix

I
To Delete an OTIS Landing Schedule Matrix

1. Click in the row containing the default landing matrix schedule you want to delete.

2. Click the Remove button.



DEC Operation Modes Tab

The OTIS DEC dialog box - Operation Modes tab, shown in Figure 37 on Page 94, is used to set the Operation Mode for
the DEC and assign a pre-configured schedule to it.

For more information, see the following:
m Operation Modes Tab Definitions on Page 94
m Operation Modes Tab Tasks on Page 95
Figure 37: OTIS DEC Dialog Box - Operation Modes Tab
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Operation Modes Tab Definitions

Table 16 on Page 94 describes the Front Reader tab field.
Table 16: OTIS DEC Dialog Box - Operation Modes Tab Definitions

Field Description

Add Adds an empty row to the table to select the Operation Modes and schedule to assign to it.

Remove Removes and deletes the selected Operation Mode and the assigned schedule from the table.




Field Description
Operation Select the Operation Mode for which this DEC is configured. User Entry of Destination Floor is the default value. You can
Modes choose one of the following:

« Default Floor Only

* Access to Authorized Floors
* User Entry of Destination Floor

« Default Floor or User Entry of Destination Floor

Schedule The schedule selected for the Operation Modes. See the C<CURE 9000 Software Configuration Guide for more information
about configuring schedules.

Operation Modes Tab Tasks

This section includes the following tasks:
m Selecting an Operation Mode for the DEC on Page 95
m Deleting an Operation Mode for the DEC on Page 95

Selecting an Operation Mode for the DEC

|
To Select an Operation Mode for the DEC

1. Click the Operation Modes tab.

2. Click the Add button.

3. Click the drop-down in the empty row under Operation Modes to list the Operation Modes.
4

Click the Operation Mode select it. The selection appears under Operation Modes.

Click in blank field under Schedule, and then click the selection button E] The Schedule selection box opens.
6. Click a schedule to select it. The selection appears under Schedule.

7. Click Save and Close

Deleting an Operation Mode for the DEC

|
To Delete an Operation Mode for the DEC

1. Click in the row containing the default landing matrix schedule you want to delete.

2. Click the Remove button.



DEC Triggers Tab

The OTIS DEC dialog box - Triggers tab, shown in Figure 38 on Page 96, is used to configure DEC related triggers to
activate events.
For more information, see the following:
m DEC Triggers Tab on Page 96
m Triggers Tab Tasks on Page 97
Figure 38: OTIS DEC Dialog Box- Triggers Tab
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Triggers Tab Definitions

The OTIS DEC dialog box — Triggers tab fields and buttons are described in Table 17 on Page 97

Table 17: OTIS DEC Dialog Box—Triggers Tab Definitions

Field/Button | Description

Add Click this button to create a new row in the Triggers table. You must configure all fields in the row to complete the Add operation.

Remove Click this button to remove a selected row from the Triggers table.

Property . . . . . L
Click in the Property field to display the selection button , and then click to select CommunicationStatus property
(the only selection available).

Value Selections are Online and Offline.

Action Click the drop-down menu to select an action to occur. This action selected will occur when the object's selected Property
receives the selected Value.

Details The name of the event configured for the row (read-only) entered by the system.

Event . . . . . .
Click the selection button to select a Event that you want to associate with the trigger. Events are created in the C.CURE
9000 Configuration pane. See the C*CURE 9000 Software Configuration Guide for more information.

Triggers Tab Tasks

The following tasks are performed in the Triggers tab:

« Selecting Triggers to Activate Events on Page 97

« Deleting Triggers and Events on Page 98

Selecting Triggers to Activate Events

|
To Select Triggers to Activate Events

1.
2.

N o g k&

dialog box.

Click the Triggers tab.
Click the Add button.

Click in the blank row under Property, and then click the selection button [I] to open the OTIS DEC Property

Click CommunicationStatus to select it.
Click in the blank field under Value.
Click the drop-down menu and select Offline or Online.

Click the drop-down menu under Action and select Activate Event.

The Event field appears at the bottom of the dialog box.

Click the selection button E]

Click a pre-configured event to activate.




10. Click Save and Close.

Deleting Triggers and Events

|
To Delete a Trigger and Event from the Elevator Group

1. Click the row selector button ¥ to select the row.

2. Click the Remove button.



DEC Status Tab

The OTIS DEC dialog box- Status tab, shown in Figure 39 on Page 99, provides read-only information about the
operational status of OTIS DEC.
Supported values are:

m Online

m Offline

m Unknown

For more information, see the following:
m Status Tab Descriptions on Page 99
Figure 39: OTIS DEC Dialog Box— Status Tab
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Status Tab Descriptions

The OTIS Elevator System Editor-Status tab fields are described in Table 18 on Page 100.



Table 18: Status Tab Definitions
- ]

Field/Button Description

Communication Status Value (Status):
* Online: The OTIS DEC is configured and communicating with the OTIS server .
« Offline: The OTIS DEC is configured, but not communicating with the OTIS server.

* Unknown: The status cannot be determined, usually displayed after the initial OTIS DEC
configuration while waiting for the OTIS server to update the status .




DEC Clearances Tab

In the Clearances support, the user will input the clearances for a DEC device. With the valid clearance at DEC, the
personnel has access to authorized floors.

The OTIS DEC dialog box - Clearances tab, shown in Figure 40 on Page 102, is used to map DEC's pre-configured
Clearances to the Schedules.

m The configured clearances and schedules in the PIN Code Clearance tab are operational only when
the Enable PIN check box in the DEC General tab is selected. For more information see, DEC Dialog
Box Definitions on Page 86.

NOTE

m Only PINs configured on the Credential tab of Personnel are supported.
m DEC-> Clearance tab is used to allow or deny access to Personnel. After it is derived, the Landing
access is derived based on Clearance Landing Matrix. All clearances need not be part of the DEC->
Clearance tab while deriving the landing access.
For more information, see the following:
m Clearances Tab Definitions on Page 102

m Clearance Tab Tasks on Page 103



Figure 40: OTIS DEC Dialog Box - Clearances Tab
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Clearances Tab Definitions

Table 19 on Page 102 describes the Landing Matrix tab fields and buttons.
Table 19: OTIS DEC Dialog Box - Landing Matrix Tab Definitions

Field/Button | Description

Add Adds an empty row to the table for selection of a Clearance and Schedule

Remove Removes and deletes the selected Clearance and Schedule from the table.




Field/Button | Description

Clearance The pre-configured personnel clearance. See the C-CURE 9000 Software Configuration Guide for more information about
configuring clearances.

Schedule The schedule selected for the Clearance. See the C<CURE 9000 Software Configuration Guide for more information about
configuring schedules.

Clearance Tab Tasks

This section includes the following tasks:
m Swiping Card or Entering Pin at Inbuilt Reader of DEC to Grant or Deny Access on Page 103

m Deriving Clearance Landing Matrix and Sending List of Authorized Floors to DEC when the card is swiped or PIN is
entered at the Inbuilt Reader of DEC on Page 104

m Deriving Clearance Landing Matrix and Sending List of Authorized Floors to DEC when the card is swiped or PIN is
entered at the External Reader of DEC on Page 105

m Deriving Clearance Landing Matrix and sending List of Authorized Floors to DEC when the card is swiped or PIN is
entered at the External Reader of DEC having multiple iStar doors under iStar Doors tab: on Page 107

m Configuring a Clearance on Page 110

m Deleting a Clearance on Page 111

Swiping Card or Entering Pin at Inbuilt Reader of DEC to Grant or Deny Access

Follow the below workflow of card swipe at inbuilt reader of DEC to grant or deny access:

NOTE This workflow is not applicable when DEC is configured with iSTAR door.
Do not configure Clearance - Schedule Mapping when iISTAR door is used for card reads.

1. Swipe the card at inbuilt reader of DEC.

2. Hex value (Card data or Pin data) received from DEC is validated against Card Formats configured under Card
Format tab, refer to DEC Card Format Tab on Page 112.

3. CHUID (Card holder Unique Identifier) is derived and Personnel is identified based on the matched card format.

4. Use the Clearance configured under Clearance tab of DEC to match if any of the Clearance configured is assigned to
Personnel or not.

5. If one of the Clearance matches with Clearances configured in Personnel under Clearance tab, then the user is
granted with the access.

NOTE Clearance configured under Clearance tab of DEC with Active schedule is used to grant access.

Clearance with Inactive schedule cannot grant access.



Deriving Clearance Landing Matrix and Sending List of Authorized Floors to DEC when the card is
swiped or PIN is entered at the Inbuilt Reader of DEC

After access is granted, follow the below workflow to derive the Clearance Landing Matrix and send the list of floors
to DEC:

Refer Table 20 on Page 104 for the configuration or mapping of Clearances.

Table 20: Configuration of Clearances

DEC (or Schedule
SL.No (or) Clearances Notes
Personnel Status
1 DEC1 Clearance 1 Active Clearances-Schedule mapping under Clearances tab of DEC
DEC1 Clearance 2 Inactive
2 Personnel1 Clearance 1 Clearances are mapped under Clearance tab of Personnel record in
Clearance 2 C-CURE 9000
Clearance 3
Clearance 4

Refer Table 21 on Page 104 for the configuration of Elevator Systems.

Table 21: Configuration of Elevator Systems

SL.No | Elevator Systems Clearances Clearance Landing Matrix (CLM) Floors

1 Elevator System1 Clearance 1 Clearance Landing Matrix 1 1,2,and 3
Elevator System1 Clearance 2 Clearance Landing Matrix 2 4,5,and 6
Elevator System1 Clearance 3 Clearance Landing Matrix 3 7,8,and9
Note: Elevator System1 does not have Clearance 4 mapped with any Clearance Landing Matrix.

Workflow:

1. When Personnel1 swipes a card at DEC1 associated with Elevator System1, then the Clearance associated under
Clearances tab of DEC is used to grant access to Personnel.

* Inthis case Clearance 1 is used to grant access. Clearance 2 cannot grant access, as it has Inactive schedule.
2. Afterthe access is granted, OTIS integration derives the list of all Clearances associated with Personnel.
* Inthis case the list includes Clearance 1, Clearance 2, Clearance 3, and Clearance 4.

3. OTIS integration will now derive the list of associated Clearance mapped with Active schedules under Clearance tab
of DEC.

4. OTIS integration performs the comparison of results derived in Steps 2 and 3, and list of Clearances with Active
schedule are shortlisted.

* Inthis case, only Clearance 1 will be derived as it is mapped to Active schedule and Clearance 2 will be ignored
as it is mapped to Inactive schedule.



5. Any additional Clearances associated with Personnel and mapped with Clearance Landing Matrix will also be
considered for Clearance Landing Matrix calculation.

* Inthis case, Clearance 3 will be considered and Clearance 4 will be ignored as it does not have any Clearance
Landing Matrix configured in system associated with Personnel.

6. OTIS integration derives the list of associated Clearance Landing Matrices with the above Clearances.
» Inthis case, following two Landing Matrices are derived:
— Clearance Landing Matrix 1
— Clearance Landing Matrix 3

» Clearance Landing Matrix 2 will not be considered as schedule associated with Clearance2 is Inactive. Also
Clearance 4 will be ignored as it does not have any Clearance Landing Matrix associated with it.

» CLMs associated with Clearances with Active schedule configured under DEC and Personnel are merged
together.

— Inthis case Clearance Landing Matrix 1 and 3 are the merged CLMs.
— As aresult, floors associated with Clearance Landing Matrices 1 and 3 are dispatched to DEC.
* Inthis case floors 1, 2, 3, 7, 8, 9 are dispatched to DEC.

Deriving Clearance Landing Matrix and Sending List of Authorized Floors to DEC when the card is
swiped or PIN is entered at the External Reader of DEC

NOTE This workflow is applicable only when DEC is configured with iISTAR readers (Doors).

Use Case: Swiping the card or entering the pin at external reader associated with DEC to Grant or Deny Access
and calculate the Clearance Landing Matrix.

After the access is granted, the OTIS integration follows the below workflow to derive the Clearance Landing Matrix and
send the list of authorized floors to DEC:
Refer Table 22 on Page 105 for the configuration or mapping of Clearances.

Table 22: Configuration of Clearances

SL.No | DEC (or) Personnel | Clearances | Notes

1 DEC1 Clearances-Schedule mapping under Clearances tab of DEC

2 Personnel1 Clearance 1 Clearances are mapped under Clearance tab of Personnelrecord in C-CURE 9000
Clearance 2
Clearance 3
Clearance 4

Refer Table 23 on Page 106 for the configuration of Elevator Systems and Clearance Landing Matrix.



Table 23: Configuration of Elevator Systems and Clearance Landing Matrix.

SL.No Elevator Systems Clearances Clearance Landing Matrix (CLM) Floors

1 Elevator System1 Clearance 1 Clearance Landing Matrix 1 1,2,and 3
Elevator System1 Clearance 2 Clearance Landing Matrix 2 4,5,and 6
Elevator System1 Clearance 3 Clearance Landing Matrix 3 7,8,and 9
Note:Elevator System1 does not have Clearance 4 mapped with any Clearance Landing Matrix.

Workflow:

1. Afterthe access is granted (in this case by iISTAR reader), the OTIS integration derives the list of all Clearances
associated with Personnel.

* Inthis case the list includes Clearance 1, Clearance 2, Clearance 3, and Clearance 4.

2. The OTIS integration derives the list of associated Clearance Landing Matrices with the above Clearances.
» Inthis case, following three Landing Matrices are derived:
— Clearance Landing Matrix 1
— Clearance Landing Matrix 2
— Clearance Landing Matrix 3

» Clearance 4 will be ignored as it does not have any Clearance Landing Matrix associated with it.

3. Clearance Landing Matrix 1, 2 and 3 will be merged together. As a result, the floors associated with Clearance
Landing Matrices 1, 2 and 3 are dispatched to DEC.

* Inthis casefloors 1, 2, 3,4, 5, 6, 7, 8, and 9 are dispatched to DEC.

NOTE Swiping the valid card at iISTAR reader and clearances with inactive Schedule-Door mapping (refer to
C+CURE 9000 Personnel Configuration Guide-Clearance) are also considered while deriving the
Clearance Landing Matrix.

NOTE Attention- If user associates iISTAR door with DEC and also captures Card Format and Schedule-
Clearance mapping on Card Format tab (refer to Figure 43 on Page 112) and Clearances tab (refer to
Figure 40 on Page 102) respectively, then the list of Authorized floors generated (merged CLMs) may
differ in case of card swipe at iISTAR reader (Door) mapped with DEC. It may also result in Denying of
access, even though personnel have valid clearance to get Access Granted at iISTAR door. This is
because, Schedules associated with the clearances under Clearances tab of DEC are not active.
Schedule-Clearance mapping done under Clearances tab of DEC takes precedence while authorizing
Personnel.



Deriving Clearance Landing Matrix and sending List of Authorized Floors to DEC when the card is
swiped or PIN is entered at the External Reader of DEC having multiple iStar doors under iStar
Doors tab:

NOTE This workflow is applicable only when DEC is configured with iStar readers (Doors).

Use Case: Swiping the card or entering the pin at external reader associated with DEC to Grant or Deny Access
and calculate the Clearance Landing Matrix.

Refer Table 24 on Page 107 for the configuration or mapping of Objects and Clearances.

Table 24: Objects and Clearances Configurations

SLNo | Objects Clearances/Doors Notes
1 DEC1 None Clearances-Schedule mapping under Clearances tab of DEC
DEC1 iStar Door 1 iStar Doors configured under iStar Doors tab of DEC

iStar Door 2

2 Personnell Clearance 1 Clearances are mapped under Clearances tab of Personnel record in
Clearance 2 CeCURE 9000
Clearance 3
Clearance 4

3 iStar Door 1 Clearance 1 iStar Door mapped to Clearances

4 iStar Door 2 Clearance 2 iStar Door mapped to Clearances

Refer Table 25 on Page 107 for the configuration or mapping of ES and Clearances.

Table 25: ES and Clearances Configurations

SLNo Elevator Clearances Clearance Landing Clearance Landing Matrix
: Systems Matrix (CLM) (CLM) floors
1 Elevator System1 Clearance 1 CLM 1 1,2and 3
Elevator Clearance 2 CLM 2 4,5and 6
System1
Elevator Clearance 3 CLM 3 7,8and 9
System1
Note: Elevator System1 does not have Clearance 4 mapped with any Clearance Landing Matrix.
Workflow:

1. When Personnel 1 swipes the card at iStar Door 1, then the access is granted as iStar Door 1 is configured under
iStar Doors tab of DEC 1. Similarly, when Personnel 1 swipes the card at iStar Door 2, then also the access is

granted.

2. Afterthe access is granted, the OTIS integration derives the list of all Clearances associated with Personnel.

In this case, the lists includes Clearance 1, Clearance 2, Clearance 3, and Clearance 4.




3. The OTIS integration derives the list of associated Clearance Landing Matrices with the above Clearances.
« Inthis case, following three Landing Matrices are derived:
« Clearance Landing Matrix 1
« Clearance Landing Matrix 2

« Clearance Landing Matrix 3
« Clearance 4 will be ignored as it does not have any Clearance Landing Matrix associated with it.
4. Clearance Landing Matrix 1, 2 and 3 will be merged. As aresult, the floors associated with Clearance Landing
Matrices 1, 2 and 3 are dispatched to DEC.
« Inthis casefloors 1, 2, 3,4, 5, 6, 7, 8, and 9 are dispatched to DEC.

Home Floor workflow with multiple Clearances for a person:

Scenario 1: Multiple Clearance Landing Matrices (CLMs) with different non-zero Home Floors associated, and if
Personnel associated with the same Clearances mapped to different CLMs and swipe at DEC then following are the

states:

« Scenario A: Home Floor mapped to the Clearance Landing Matrix with Clearance that is assigned at last to the
Personnel is dispatched.

« Scenario B: If the driver restarts, then the Home Floor with maximum ClearancelD will be dispatched.

Example: When multiple Clearance Landing Matrices (such as CLM 1, CLM 2 and CLM 3) with different non-zero Home
Floors are associated, refer Figure 41 on Page 108, and Personnel with same Clearances refer Figure 42 on Page 109

CLM 1 with Home Floor as 4, CLM 2 with Home Floor as 3 and CLM 3 with Home Floor as 10 and Personnel1 with
Clearances as Clearance1, Clearance2 and Clearance3.

« With reference to Scenario A, Home Floor 10 will be dispatched.
« With reference to Scenario B, Home Floor dispatch depends on the ClearancelD.

Figure 41: Multiple CLMs- Non Zero Home Floors

[ F e T

(T X

wmerphion



Figure 42: Personnelwith same Clearances
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Scenario 2: Multiple Clearance Landing Matrices with one non-zero Home Floor associated with one CLM and the
remaining have a default value as zero for Home Floor and if Personnel associated with same Clearances associated with
different CLMs swipe at DEC, then the non-zero Home Floor will be dispatched.

Example: When a person has multiple Clearances (such as Clearance 1, Clearance 2 and Clearance 3) refer Figure 42 on
Page 109

a. Clearance 1 associated with CLM1, with the Home Floor set as 5 and respective Default Landing Matrices (DLM)
should be added to the Landing Matrix. Refer below figure:

. 0TS DEC Clearance Landing Matrix - CLM1 - *

; Save and Close

Name: [CLM1|

Description:

General

Elevator System  TestES

Clearance Name |[]earanc:e'| |E|IZI
Home Floor ® Front () Rear

f == Add == Remove

Landing Matrix

b. Clearance 2 associated with CLM2, with the home Floor set as 0, and the Default Landing Matrices should not be
added to the Landing Matrix. Refer below figure:



Then, when a person swipes a card at DEC1 which is associated with Clearance 1, the non-zero Home Floor (5 in this

OTIS DEC Clearance Landing Matrix - CLM2

; Save and Close

Name: (CLM2

Description:

General

Elevator System TestES

Clearance Name |Clearance2

=

Home Floor 0 |3 (@) Front

== Add Remowve

(") Rear

Landing Matrix

case, which is associated with CLM1) should be dispatched correctly.

The system behavior should be the same even after the Otis driver service is restarted.

Configuring a Clearance

To Configure a Clearance

1.
2.

NOTE

Click the Clearances tab.

Click the Add button.

Click a schedule to select it. The selection appears under Schedule.

Click Save and Close.

User can add only one row combination of a Clearance and Schedule.

c. Clearance 3 associated with CLM3, with the home Floor set as 0, and the Default Landing Matrices should not be
added to the Landing Matrix.

Click the selection button [I] in the empty row under Clearance to open the Clearance selection box.

Click a Clearance to select it. The selection appears under Clearance.

Click in blank field under Schedule, and then click the selection button E] The Schedule selection box opens.

For personnel configured with multiple clearances, it is recommended to add all the clearances assigned to personnel with
appropriate schedule. Configuration of common clearance with Always schedule is not recommended. This will result in getting all
personnel access to DOP 24*7.




Deleting a Clearance

|
To Delete a Clearance

1. Click in the row containing the Clearance you want to delete.

2. Click the Remove button.



DEC Card Format Tab

You can associate the pre-configured card format with the DEC using the OTIS DEC-Card Format tab.

Once you map the card format with the DEC, only the associated card formats will be considered for credential evaluation
on any card swipe done on this DEC.

0 You can map only the pre-configured card formats with DEC using OTIS DEC-Card Format tab. You can create
NOTE new card formats using the Card Format Editor. For more information, see Card Format Editor in CeCURE 9000
User Manual. CHUID length supported by OTIS integration is 80.

For more information, see the following:
m Card Format Tab Definitions on Page 112
m Card Format Tab Tasks on Page 112
Figure 43: Figure41:OTISDEC -Card Format Tab

[ omspEC - DEC25 = =2 =

[H save andClase

Hame:  DEC253

Dessrption:

atus | Cleaances | Card Format | State images|

Name Description

Card Format Tab Definitions

Table 20 on Page 121 describes the Card Format tab fields and buttons.
. ____________________________________________________________________________________________________|

Field/Button Description

Add Click this button to map a card format with the DEC.

Remove Click this button to remove the associated card format from the DEC.
Name The name of the card format that you want to associate with the DEC.
Description Description about the selected card format.

Card Format Tab Tasks

This section includes the following tasks:



m Mapping a Card Format with the DEC on Page 113

m Deleting a Card Format on Page 113

Mapping a Card Format with the DEC

|
To Map a Card Format

Before you Begin

Ensure that all the required card formats are configured in the C<CURE 9000 Card Format Editor.
1. Click the Card Format tab.

2. Click Add.

3. Click in the empty row under Name to open the selection box.

4. Click a card format to select. The selection appears in the table with the name and description.

5. Click Save and Close.

Deleting a Card Format

]
To Delete a Card Format

1. Select the card fromat that you want to delete.

2. Click Remove.



DEC iStar Doors Tab
The OTIS DEC -iStar Doors tab, shown in Figure 44 on Page 114, is used to assign a pre-configured iStar door to a DEC.

Single iStar Door configuration option from General tab is removed as iStar Doors tab is added to support multiple
NOTE iStar doors under DEC.
For more information, see the following:
m iStar Doors Tab Definitions on Page 114

m iStar Doors Tab Tasks on Page 115

Figure 44: OTIS DEC - iStar Doors Tab

OTISDEC - 108 - doorl - clrd - LM 3,4F — *

E Save and Close

Name: (108 - doorl - cird - LM 3.4F

Description: -

[ Maintenance Mode

Schedule Matrix  Operation Modes  Triggers  Status  Clearances  Card Format  i5tar Doors Stmeim;EIIl

P2 Add 5. Remove

MName

iStar Doors Tab Definitions

Table 20 on Page 121 describes the iStar Doors tab fields and buttons.



Field/Button Description

Add Click this button to map a iStar Door with the DEC.

Remove Click this button to remove the associated iStar Door from the DEC.
Name The name of the iStar Door that you want to associate with the DEC.

iStar Doors Tab Tasks
This section includes the following tasks:
m Mapping a iStar Door with the DEC on Page 115

m Deleting aiStar Door on Page 115

Mapping a iStar Door with the DEC

|
To Map a iStar Door

Before you Begin

Ensure that all the required iStar Doors are configured in the C*CURE 9000 iStar Door Editor.

1. Click the iStar Doors tab.

2. Click Add.

3. Click in the empty row under Name to open the selection box.

4. Click aiStar Door to select. The selection appears in the table with the name and description.

5. Click Save and Close.

Deleting a iStar Door

|
To Delete a iStar Door

1. Select the iStar Door that you want to delete.
2. Click Remove.

3. Click Save and Close.



DEC State Images Tab

The State Images tab, shown in Figure 45 on Page 116 displays the current DEC images that display in the Monitoring
Station to represent the activities concerning the DEC. You can select otherimages to display for this DEC and return
back to the default images, as described in this section.

See State Images Tab Tasks on Page 70 for information about changing the state images.

Figure 45: OTIS DEC Dialog Box — State Images Tab
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E Save and Close |

MName: DEC253

D escription: L
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State Images Tab Tasks

The following tasks are performed in the State Images tab:
m Replace a State Image on Page 116

m Restore the Default State Image on Page 117

Replace a State Image

|
To Replace an Image

1. Double-click the default image in the tab to open a Windows file selection dialog box.



2. If necessary, navigate to find the new image.

3. Select the desired replacement image and click Open.

The new image replaces the default image and displays in the State Images tab.

Restore the Default State Image

|
To Restore the Default Image

m Right-click the image in the State Images tab and select Restore Default.



OTIS User Types

This chapter describes how to associate personnel to a User Type. The User Type represents information pertaining to the
credential holder.

In this chapter

Accessingthe User Type Dialog BoX . .. ... L 119
OTIS User Type Dialog BOX ...l 120



Accessing the User Type Dialog Box

This section explains how to access the OTIS User Type dialog box.

NOTE The OTIS Elevator System (OTIS Elevator System Editor Dialog Box on Page 26), OTIS Default
Landing Matrix (OTIS Default Landing Matrix Dialog Box on Page 59) OTIS Landing (OTIS Landing
Dialog Box on Page 65) and Clearance Landing Matrix must be configured before you can configure

the User Type.

|
To Access the User Type Dialog Box

1. Click the elevator system icon under the OTIS Elevator System folder under the Hardware tree and select
OTIS User Type>New, as shown in Figure 46 on Page 119.

Figure 46: Accessthe User Type Dialog Box
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The OTIS User Type dialog box, shown in Figure 47

on Page 120 opens.



OTIS User Type Dialog Box

The OTIS User Type dialog box, shown in Figure 47 on Page 120, is used to associate personnel group to a User type.
OTIS allows a user to have combination of User Type. The different User Type are Standard, TD04, TD08, TD10, TD20,
TD40, and TD80. Type Descriptor (TD) defines information pertaining to the credential holder. For example, standard,
person with disability, VIP, vertigo susceptible.

Standard and ADA user cannot not be combined.

NOTE

NOTE Per Elevator System, only one object can be created for User Type.
For more information, see the following:
m Accessing the User Type Dialog Box on Page 119
m User Type Dialog Box Definitions on Page 120
m User Type Dialog Box Tasks on Page 121

Figure 47: OTIS User Type Dialog Box
\Lll OTIS User Type - =] A ||

g Save and Close |

Mame: I\

Description:

=l
El

User Type |

Elevator System IEIevaiur_'l

: == Add = Remove l

Persornel Group | Standard | TDO4 | TDOE | TD10 | TD20 | TD40 | TDBO

User Type Dialog Box Definitions

Table 26 on Page 121 describes the OTIS User Type dialog box- General tab fields and buttons.



Table 26: OTIS User Type Dialog Box - General Tab Definitions
-]

Field/Button Description

Name A unique name identifying the User Type configuration.
* The name is not case-sensitive
* Minimum number of characters: 1

* Maximum number of characters: 100

Description Optional. A description for the User Type configuration.
* The description is not case-sensitive.
* Minimum number of characters: None

* Maximum number of characters: 500

Save and Close Saves the configuration and closes the dialog box

User Type Tab

Elevator System The name of the OTIS Elevator System. This field is read-only.

Add Click this button to create a new row in the User Type table. You must configure all fields in the row to

complete the Add operation.

Remove Click this button to remove a selected row from the User Type table.

Personnel Group Click the selection button L) to select the pre-configured personnel group. See the C-=CURE 9000 Software
Configuration Guide for information on creating personnel groups.

Standard Standard- Indicates standard passenger type. Standard is the default TD.

TDO04 Represents that the Personnel Group has Very Important Person (VIP)status. a Enable to designate this
person as a Very Important Person (VIP for Otis Compass passenger allocation

TDO08 Represents that the Personnel Group is susceptible to Vertigo or similar conditions.
TD10 Represents that Personnel Group is eligible for Split Group Operation (SGO).

TD20 Represents that the Personnel Group is susceptible to Vertigo 2 or similar conditions.
TD40 Represents that the Personnel Group is applicable for Cart Svc.

TD80 Represents that the Personnel Group is designated to CIM Override.

For Americans with Disabilities (ADA) status configuration refer to the CeCURE 9000 Personnel
NOTE ) : )
Configuration Guide.

User Type Dialog Box Tasks

This section describes the following tasks:
m Configuring a User Type on Page 122
m Editing a User Type Configuration on Page 122



m Viewing All User Type Configurations on Page 122
m Deleting a User Type Configuration on Page 122

Configuring a User Type

|
To Configure a User Type

1. Right-click the elevator system icon under the OTIS Elevator System folder in the Hardware tree and select
OTIS User Type>New.

The OTIS User Type dialog box opens.

2. Enter aname, of up to 100 characters, for the User Type in the Name field.

3. Inthe User Type tab, click the Add button.

4. Click in the blank row under Personnel Group, and then click the selection button [z] to select the Personnel
Group.

5. Select the Personnel Group from the list.

6. Click inthe check box to select the User Type for the Personnel Group.

7. Click Save and Close to save the configuration.

Editing a User Type Configuration

|
To Edit a User Type Configuration

1. Double-click the User Type configuration in the tree that you want to edit.
Alternately, you can right-click the User Type configuration in the tree and select Edit from the context menu.
2. Make the changes to the configuration.

3. Click Save and Close.

Viewing All User Type Configurations

|
To View All User Type Configurations

1. Click the Hardware drop-down menu and select OTIS User Type.

2. Click the green right arrow &4 located to the right of the Hardware drop-down menu.

The OTIS User Type tab opens in the Dynamic View displaying a list of OTIS User Type configurations.

Deleting a User Type Configuration

|
To Delete a User Type Configuration

1. Right-click the User Type configuration that you want to delete and select Delete from the context menu.
The Deleting OTIS User Type objects dialog box opens.

2. Click Yes to confirm the deletion.



The object is deleted.
3. Click OK to confirm that the object was deleted.
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OTIS Events and Actions

This chapter describes the C<«CURE 9000 events which triggers OTIS Actions and the steps to configure them.

In this chapter

OIS BVeNtS . 125
OTIS Actions and Target ObjeCts . ... . 126
Configuring C*CURE Events for OTIS ACtioNs ... . 127



OTIS Events

An event is a software definition that you can create using CCURE 9000 dialog boxes and options. Anything that
C-CURE 9000 can monitor can be used to generate an event, and the event can trigger any action. You can link an event
directly to a single action or you can link it to multiple events and actions. In the C+.CURE 9000 OTIS Elevator Integration
you can use an event to trigger event actions.
For more information, see the following:

m OTIS Actions and Target Objects on Page 126

m Configuring C<CURE Events for OTIS Actions on Page 127



OTIS Actions and Target Objects

An action is a series of tasks, or a single task, that's executed when an event occurs. The target object is an object on

which the action is to be taken when an event occurs.

Table 27 on Page 126 describes the OTIS action and target objects.

Table 27: OTIS Action and Target Objects

Action Target Object Description

Secure Landing OTIS Landing Select a Landing that you want to secure. This action inhibits the doors
associated with the Landing. When a landing is secured, only people in
an exemption (personnel) Group could access the landing.

Un-secure Landing OTIS Landing Select a Landing to you want to unsecure. When a landing is

unsecured, anybody can access it.




Configuring C°CURE Events for OTIS Actions

The two OTIS event actions, Secure Landing and Un-secure Landing, are time-based events. You create a manual action
and then schedule the time to secure or un-secure a landing.

This section describes the following tasks:

Configuring the Secure Landing Event on Page 127

Configuring the Un-secure Landing Event on Page 128

Configuring the Secure Landing Event

|
To Configure the Secure Landing Event

1.

© © N o o & 0w N

—_
o

1.
12.

13.
14.
15.

16.

17.
18.

In the Navigation pane of the Administration Workstation, click Configuration to open the Configuration Pane.
Select Event from the Configuration drop-down list.

Click New to create a new Event. The Event Editor opens.

Enter a name for this Event in the Name field.

Enter a description for this Event in the Description field.

Click Enabled to make the Event available to C+.CURE 9000 operators.

Click the Actions tab to define the action that you want to set for the Event.

Click Add.

Click in the Action column to display a drop-down list of valid actions.

. Select Secure Landing.

When you select Secure Landing option, the OTIS Landing entry field appears at the bottom of the dialog box.

Click the selection button B to select a pre-configured OTIS Landing.

(Optional) Click in the Resettable check box if you want to allow an operator responding to the Event to reset the
action without acknowledging the Event. This allows Monitoring Station personnel to manually reset the action
caused by the event. Reset actions do not require even acknowledgment.

Click the General tab.
In the Default State section, click Armed to arm the event as the default state.

In the Priority section, select a value from the drop-down to set the priority level the system uses for sorting when
displaying on the Monitoring Station and prioritizing actions associated with the event.

In the Scheduling section, click the Activate on Schedule selection button E] to open a selection box listing
schedules.

Click a schedule to select it.

Click Save and Close to save the configuration.



Configuring the Un-secure Landing Event

|
To Configure the Un-secure Landing Event

1. Inthe Navigation pane of the Administration Workstation, click Configuration to open the Configuration Pane.
Select Event from the Configuration drop-down list.

Click New to create a new Event. The Event Editor opens.

Enter a name for this Event in the Name field.

Enter a description for this Event in the Description field.

Click Enabled to make the Event available to C*CURE 9000 operators.

Click the Actions tab to define the action that you want to set for the Event.

Click Add.

© © N o o &~ 0 DN

Click in the Action column to display a drop-down list of valid actions.

—_
o

. Select Un-secure Landing.

When you select the Un-secure Landing option, the OTIS Landing entry field appears at the bottom of the dialog box.

11. Click the selection button E] to select a pre-configured OTIS Landing.

12. (Optional) Click in the Resettable check box if you want to allow an operator responding to the Event to reset the
action without acknowledging the Event. This allows Monitoring Station personnel to manually reset the action
caused by the event. Reset actions do not require even acknowledgment.

13. Click the General tab.
14. In the Default State section, click Armed to arm the event as the default state.

15. In the Priority section, select a value from the drop-down to set the priority level the system uses for sorting when
displaying on the Monitoring Station and prioritizing actions associated with the event.

16. In the Scheduling section, click the Activate on Schedule selection button E] to open a selection box listing
schedules.

17. Click a schedule to select it.

18. Click Save and Close to save the configuration.
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Monitoring OTIS Elevator Activity

This chapter describes the C<«CURE 9000 Monitoring Station Activity Viewer and also provides the procedure to cancel OTIS
manual actions.

In this chapter

C-CURE 9000 Monitoring Station Activity VieWer . 130
Canceling Manual ACtiONS ... il 131



C-CURE 9000 Monitoring Station Activity Viewer

The C-CURE 9000 Monitoring Station Activity Viewer, shown in Figure 48 on Page 130, displays the OTIS access
control activities.

Activities in the list are displayed in rows that contain an icon, the date and time of the activity, the type of activity or
object, its name, the object’s partition name [in brackets], and an activity message. You can click the activity icon to view
additional information about the object, or right-click the icon to display the context menu for more options or to initiate a
manual action.

NOTE There is no journalling for Floor selection if the ICD version is 1.0.

See the C+CURE 9000 Monitoring Station Guide for more information about the Activity Viewer.
Figure 48: Monitoring Station Activity Viewer
T2 v @Eas
Date - Time Activity

6/5/2021 5:32.33 FM

Event '0OTIS ES Offling’ is inactive.

System Activity: OTIS Driver Service started on computer WIN-F3ODREFSJUP".

‘DES 240 is Online

Ij 6/5/2021 53240 PM

11 6/5/2021 5:32:40 PM 'DEC 1'is Online
6/5/2021 5:32:41 PM "DEC 11'is Online
E E 6/5/2021 5:32:41 PM ‘DEC 12%is Online

Admitted "1, Personnel” at ‘DEC 1°.

@ 6/5/2021 53319 PM
E 6/5/2021 5:33:22 PM
—

@ 6/5/2021 53335 PM

=
@ 6/5/2021 5:33:45 FM
—

@ 6/5/2021 5:33:55 FM

—
@ 6/5/2021 5:33:58 PM

=
@ 6/5/2021 5:34:07 PM

"1, Personnel’ selected landing 10 Front and assigned Bank/Group 3, Car 5"
Admitted "1, Personnel’ at ‘DEC 1°.

"1, Personnel’ failed to select landing  with Reason Code 10"

Admitted 1, Personnel’ at ‘DEC 1°.

"1, Personnel' failed to select landing 11 Front with Reason Code 2"

Admitted "1, Personnel” at ‘DEC 1°.

=
652021 53410 PM ", Personnel failed to select landing -9 Frort with Reason Code 1"
=
6/5/2021 5:34:21 PM Admitted "1, Personnel’ at 'DEC 1°.
=

"1, Personnel’ selected landing 10 Front and assigned Bank/Group 0, Car 4"



Canceling Manual Actions

This section describes how to cancel the Secure Landing and Un-Secure Landing manual actions in the Monitoring

Station.

To Cancel a Manual Action in the Activity Viewer

1. Go to the Monitoring Station Activity Viewer, as shown in Figure 49 on Page 131.

S CCURE 9000 - Monitoring Station (APP_appserver2 k[ TKSAS]

Operater  Help

Mon Hardwar... 2
Hardware St... %

Video k]

= Servers

[fi Cameras

E Tours

2 CCTV Switches
{6 CCTV Cameras
&' IP Cameras
Fe Views

ExternalAppl... ¥

Figure 49: Monitoring Station Activity Viewer

=10 x]

! 4 V C-CURE 9000

"-' 17:03-2014 12-45:28
1703-2014 124528
{_, 17-03-2014 12:46:44
17032014 12-46:44

;-, 17-03-2014 12:46:50

17-03-2014 12-46:50

2 Unleck OTISCCURERor " [Bevalor] from 17403-2014 12:45:1910

R

Manual action by 'APP_appeerver?’: Lock OTISCCURERoor 2 [Bevator] from 17-403-2014 12:45:2510
1703-2014 13:45:00.

Foor "2 is secured

Marusal action by 'APP_sppserver?: Lock OTISCCURERsar "1 [Bevatoe] from 17-03-2014 12:46:4710
17-03-2014 13:46:00

Floor 1" is secuned

Marwsal action by ‘APP_appsenver?: Unlock OTISCCURERoar 2 [Bevator] from 17403-2014 12:46:47 10
17-03-2014 13:46:00.

Foor "2 s unsscunad

A list of all activities since the Monitoring Station was opened are displayed.

2. Under the Explorer Bar click Non-Hardware Status.

3. Under Non-Hardware Status click Manual Actions.

The Status List - Manual Action dialog box opens displaying a list of manual actions and their current status.

4. Right-click the manual action in the dialog box that you want to cancel and select Cancel from the drop-down menu,
as shownin on Page 131.

Figure 50: Canceling the Manual Action

=
E% e C){}@h Count: 5.
Drag columns to group by here
Start Time | End Time | Priority Operator Name Status | Target | Partition
17-03-20141 17-03-20141 APP_sppserver?  Canceled 1 Elevatar
17-03-20141 17-03-20141 APP_appserver?  Active 1 Elevator

17-03-20141 17-03-2014 1

Details

APP_appserver? Elevator

17-03-2014 1 17-03-2014 1

APP_appserver?  Active 2 Elevatol Cancel |




A new entry appears in the Activity Viewer to indicate that the manual action was canceled.
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Journal and Audit Messages

This chapter discusses the Journal and the Audit messages and how to locate them.

In this chapter

Journal and Audit LOg MeSSages ... oL 134
Locating OTIS Objects inthe JOUMal .. ... ... 136
Locating OTIS Audit Log ENtries .. 137



Journal and Audit Log Messages
Table 28 on Page 134 lists the journal messages reported by the OTIS Elevator System to the C<CURE 9000 database.

All configuration changes to the OTIS Elevator System objects are recorded to the Audit Log.

Table 28: JournalLog Messages

Category Object State Changes Message Description
Elevator System Online <name of the Elevator System>is Online
. Offline <name of the Elevator System> is Offline
Object Change State
DEC Online <name of the DEC>is Online
Offline <name of the DEC>is Offline
System Activity Driver Start System Activity: OTIS Elevator Driver Service started on
computer <computer name>
Stop System Activity: OTIS Elevator Driver Service stopped on
computer <computer name>
Manual Actions Landing Secure Manual action by <Operator Name> lock <OTIS CCUREFIoor
<Landing Name>from <Date Start time>to <Date End Time>
Unsecure Manual action by <Operator Name> unlock <OTIS CCUREFIloor
<Landing Name>from <Date Start time>to <Date End Time>
Floor Selection Landing NA <Personnel Name> selected <Landing
Name><Side>and assigned Bank/Group <No>, Car
<No>
Missed Floor selection Landing NA <Personnel Name> failed to select landing with Reason
after valid Pin Code Code 10
Entry/Card Swipe
Denied Floor Access Landing NA <Personnel Name> failed to select <Landing
Name> <Side>with Reason Code <no>
Pin Code Entry/Card Personnel NA <Personnel Name> is admitted at <name of the DEC>
Swipe
Pin Code Entry/Card Personnel NA Rejected (Disabled)<Personnel Name> at <name of the
Swipe DEC>
Pin Code Entry/Card Personnel NA Rejected (Clearance)<Personnel Name> at <name of
Swipe the DEC>
Pin Code Entry/Card Personnel NA Rejected (Card disabled) <Personnel Name>at <name
Swipe of the DEC>
Card Swipe Personnel NA Access Denied -Card Unknown <Hex Value> at
<name of the DEC>




Category Object State Changes Message Description

Pin Code Entry/Card Personnel NA Rejected (Expired) <Personnel Name> at <name of the

Swipe DEC>

Card Swipe Personnel NA Rejected (Lost) <Personnel Name> at <name of the
DEC>

Pin Code Entry/Card Personnel NA Rejected (Stolen) <Personnel Name> at <name of the

Swipe DEC>

Pin Code Entry Personnel NA Unknown user pin entry occurred at <name of the DEC>




Locating OTIS Objects in the Journal

You can search for journal entries related to the OTIS Elevator.

To Locate Journal Entries for an OTIS Elevator Object
1. Right click an OTIS Elevator object in the Hardware Tree and select Find in Journal from the context menu.
The Query Parameters dialog box opens.

By default the query searches in the Journal for occurrences of the selected OTIS Elevator System object within the
last 7 days.

2. Click Run.
A Query - Journal for dialog box opens displaying the Journal Entries for the OTIS Elevator object.

Alternatively, you can click Modify to modify the query definition, adding or removing query parameters.

OTIS objects, such as the OTIS Clearance Landing Matrix, OTIS Default Landing Matrix,
OTIS Landing and, OTIS DEC, cannot be removed from the Journal Query due to a C*CURE
9000 limitation.

NOTE



Locating OTIS Audit Log Entries

You can search for Audit Log Entries related to the OTIS Elevator objects.

To Locate Audit Log Entries for OTIS Elevator Objects
1. Select Options and Tools>Audit Log.

The Query parameters dialog box opens.
By default the query searches in the Audit Log for occurrences of the selected object within the last 7 days.

2. Click Run.
The Query - Audit Log opens displaying the Audit Log Entries for all OTIS Elevator objects.

Alternatively, you can click Modify to modify the query definition, adding or removing query parameters.
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Troubleshooting

This chapter helps to resolve problems you may encounter with C+.CURE 9000 OTIS Elevator Integration.

In this chapter

TroUbIES OO NG . .. 139



Troubleshooting

Problem

Solution

Problem

Solution

NOTE

Manual action performed with same start and end time does not revert the action.

Cancel the Manuel Action manually. For information see, Canceling Manual Actions on Page 131.

Personnel details reported in monitoring station do not match the personnel details of the card
presented at DEC.

Ensure card numbers are not duplicated. If two cards have the same number, change the number
of one of the cards.

This occurs when card formats share the same data length and both card formats have been assigned to
the DEC.



Third-Party Copyright and Trademarks

In this appendix

Microsoft Limited Public License Information . ... . ... 141

C+CURE 9000 OTIS Elevator System Integration Guide Appendix A 140



Microsoft Limited Public License Information

Microsoft Limited Public License Information

This software uses QueuedTaskedScheduler part of Microsoft Parallel Extensions Extra Library in
assembly

TSP.Enterprise.Server.ConcurrentTaskLibrary.dll under LPL 1.1 license.

MICROSOFT LIMITED PUBLIC LICENSE version 1.1

This license governs use of code marked as “sample” or “example” available on this web site without a
license agreement, as provided under the section above titled “

NOTICE SPECIFIC TO SOFTWARE AVAILABLE ON THIS WEB SITE.” If you use such code (the
“software”), you accept this license. If you do not accept the license, do not use the software.

1. Definitions
The terms “reproduce,” “reproduction,
as under U.S. copyright law.

derivative works,” and “distribution” have the same meaning here

A “contribution” is the original software, or any additions or changes to the software.
A “contributor” is any person that distributes its contribution under this license.
“Licensed patents” are a contributor’s patent claims that read directly on its contribution.

2. Grant of Rights

(A) Copyright Grant - Subject to the terms of this license, including the license conditions and limitations
in section 3, each contributor grants you a non-exclusive, worldwide, royalty-free copyright license to
reproduce its contribution, prepare derivative works of its contribution, and distribute its contribution or
any derivative works that you create.

(B) Patent Grant - Subject to the terms of this license, including the license conditions and limitations in
section 3, each contributor grants you a non-exclusive, worldwide, royalty-free license under its licensed
patents to make, have made, use, sell, offer for sale, import, and/or otherwise dispose of its contribution
in the software or derivative works of the contribution in the software.

3. Conditions and Limitations

(A) No Trademark License- This license does not grant you rights to use any contributors’ name, logo, or
trademarks.

(B) If you bring a patent claim against any contributor over patents that you claim are infringed by the
software, your patent license from such contributor to the software ends automatically.

(C) If you distribute any portion of the software, you must retain all copyright, patent, trademark, and
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attribution notices that are present in the software.

(D) If you distribute any portion of the software in source code form, you may do so only under this license
by including a complete copy of this license with your distribution. If you distribute any portion of the
software in compiled or object code form, you may only do so under a license that complies with this
license. (E) The software is licensed “as-is.” You bear the risk of using it.

The contributors give no express warranties, guarantees or conditions. You may have additional
consumer rights under your local laws which this license cannot change.

To the extent permitted under your local laws, the contributors exclude the implied warranties of
merchantability, fitness for a particular purpose and non-infringement.

(F) Platform Limitation - The licenses granted in sections 2(A) and 2(B) extend only to the software or
derivative works that you create that run directly on a Microsoft Windows operating system product,
Microsoft run-time technology (such as the .NET Framework or Silverlight), or Microsoft application
platform (such as Microsoft Office or Microsoft Dynamics).
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